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Preface

The purpose of this guide is to help NetBackup system administrators install and
configure NetBackup™. The NetBackup system administrator is responsible for
maintaining backups and disaster recovery plans using NetBackup.

This guide assumes the following:

¢ The NetBackup System Administrator possesses a basic understanding of Microsoft
Windows system administration.

¢ The NetBackup System Administrator has had experience with the system on which
NetBackup is to be installed.

¢ That all SCSI devices are properly attached and configured for the operating system.

Caution If a device is not properly configured for the operating system, backups made to
that device may lead to backup failure and/or data loss.

What is in this manual?

This document is designed to step you through the installation process of the NetBackup
Server or NetBackup Enterprise Server product. The installation procedures in this
document step you through a typical NetBackup Server installation. The installation
process for NetBackup Server is nearly identical for the NetBackup Enterprise Server
product. Any differences in the installation process between the two products are
identified in this document.

Within this document are general descriptions of the major components of NetBackup. In
addition, this document provides easy-to-follow procedures about:

¢ Understanding and learning the basics of NetBackup

¢ Installing NetBackup server software
¢ Upgrading your current system with the latest version of NetBackup
¢ Uninstalling NetBackup from your server
¢ Installing alternate interfaces
vii -



Getting Help
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Installing NetBackup client software

Uninstalling NetBackup client software

Getting Help

VERITAS offers you a variety of support options.

Accessing the VERITAS Technical Support Web Site

The VERITAS Technical Support Web site allows you to do any of the following:

4
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obtain updated information about NetBackup, including system requirements,
supported platforms, and supported peripherals

contact the VERITAS Technical Support staff and post questions to them
get the latest patches, upgrades, and utilities

view the NetBackup Frequently Asked Questions (FAQ) page

search the knowledge base for answers to technical support questions
receive automatic notice of product updates

find out about NetBackup training

read current white papers related to NetBackup

The address for the VERITAS Technical Support Web site follows:

http://support.veritas.com

Using VERITAS Telephone and E-mail Support

Telephone support for NetBackup is only available with a valid support contract. To
contact VERITAS for technical support, dial the appropriate phone number listed on the
Technical Support Guide included in the product box and have your product license
information ready for quick navigation to the proper support group.

¥ To locate the telephone support directory on the VERITAS web site

1.

2,

Open http://support.veritas.comin your web browser.

Click the Phone Support icon. A page that contains VERITAS support numbers from
around the world appears.
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Related Resources

Vv To contact support using E-mail on the VERITAS web site
1. Openhttp://support.veritas.comin your web browser.

2. Click the E-mail Support icon. A brief electronic form appears and prompts you to:
¢ Select a language of your preference
¢ Select a product and a platform
¢ Associate your message to an existing technical support case
*

Provide additional contact and product information, and your message

3. Click Send Message.

Related Resources

Appendix A, “Related Documents” on page 111 contains a complete list of books that
provide additional product information. These documents are a natural progression for
users who wish to learn more about NetBackup and the many features this product offers.

Glossary

If you encounter unfamiliar terminology, consult the NetBackup online glossary. The
glossary contains terms and definitions for NetBackup and all additional NetBackup
options and agents.

The NetBackup online glossary is included in the NetBackup help file.

Vv To access the NetBackup online glossary
1. In the NetBackup Administration Console, click Help > Help Topics.
2. Click the Contents tab.

3. Click Glossary of NetBackup Terms.

Use the scroll function to navigate through the glossary.
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Accessibility Features

Additional NetBackup Server and Client Installation Terms

The following terms are used in this document in reference to clustered environments.

Active node

The designated node in a clustered environment where NetBackup is installed and from
which NetBackup can push to other nodes in the cluster. In addition, the NetBackup
services are running on an active node.

Inactive node

An inactive node in a clustered environment has NetBackup installed, however
NetBackup and the NetBackup services are not running.

Migrating

Migrating, commonly referred to as failover, occurs when a node becomes unavailable,
and the cluster resources are migrated to an available node.

Nodes

In a server cluster, two or more servers (called nodes) are linked in a network, and run
cluster software that allows each node access to the shared SCSI bus to which any number
of disks can connect.

Primary node or preferred node

The node in a clustered environment that is intended to be active the majority of the time.

Virtual Host name

The name of the cluster as known by the NetBackup environment. This is the name that
the clients will have in their server list. It is also the name that the server uses when
communicating to the client nodes.

Virtual IP address

This is the IP address of the cluster. The address that the virtual server name should
resolve to.

Accessibility Features

NetBackup contains features that make the user interface easier to use by people who are
visually impaired and by people who have limited dexterity. Accessibility features
include:

¢ Support for assistive technologies such as screen readers and voice input (Windows
servers only)
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¢ Support for keyboard (mouseless) navigation using accelerator keys and mnemonic
keys

For more information, see the NetBackup System Administrator’s Guide for Windows,
Volume I or the NetBackup System Administrator’s Guide for UNIX, Volume I.

Conventions

The following section explains typographical and other conventions used in this guide.

Product-Specific Conventions

The following term is used in NetBackup documentation to increase readability while
maintaining technical accuracy.

& Microsoft Windows, Windows

Generic terms used to describe a specific product or operating system developed by
Microsoft, Inc. Some examples are, Windows 2000, Windows Server 2003, Windows
servers, Windows clients, Windows platforms, or Windows GUI. For more
information on the Windows operating systems that NetBackup supports, refer to the
VERITAS NetBackup Release Notes for UNIX and Windows or go to the VERITAS support
web site at http: //www. support.veritas.com.

Note When a specific Windows product is identified in the documentation, only that
particular product is valid in that instance.

Typographical Conventions

Here are the typographical conventions used throughout the manuals:

Conventions
Convention Description
GUI Font Used to depict graphical user interface (GUI) objects, such as fields, list
boxes, menu commands, and so on. For example: Enter your password in
the Password field.
A4
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Conventions

Conventions (continued)

Convention Description

Italics Used for placeholder text, book titles, new terms, or emphasis. Replace
placeholder text with your specific text. For example: Replace filename
with the name of your file. Do not use file names that contain spaces.

This font is also used to highlight NetBackup server-specific or operating
system-specific differences. For example: This step is only applicable for
NetBackup Enterprise Server.

Code Used to show what commands you need to type, to identify path names
where files are located, and to distinguish system or application text that
is displayed to you or that is part of a code example.

Key+Key Used to show that you must hold down the first key while pressing the
second key. For example: Ctrl+S means hold down the Ctrl key while
you press S.

You should use the appropriate conventions for your platform. For example, when
specifying a path, use backslashes on Microsoft Windows and slashes on UNIX.
Significant differences between the platforms are noted in the text.

Tips, notes, and cautions are used to emphasize information. The following samples
describe when each is used.

Note Used for important information that you should know, but that shouldn’t cause any
damage to your data or your system if you choose to ignore it.

Caution Used for information that will prevent a problem.

Command Usage
The following conventions are frequently used in the synopsis of command usage.
brackets [ ]
The enclosed command line component is optional.
Vertical bar or pipe ()

Separates optional arguments from which the user can choose. For example, when a
command has the following format:

command argl|arg2

In this example, the user can use either the arg1 or arg2 variable.

- xii
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Navigating Multiple Menu Levels

When navigating multiple menu levels, a greater-than sign (>) is used to indicate a
continued action.

The following example shows how the > is used to condense a series of menu selections
into one step:

< Select Start > Programs > VERITAS NetBackup > NetBackup Administration
Console.

The corresponding actions could be described in more steps as follows:
1. Click Start in the task bar.

2. Move your cursor to Programs.

3. Move your cursor to the right and highlight VERITAS NetBackup.

4. Move your cursor to the right. First highlight and then click NetBackup
Administration Console.

Preface
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NetBackup Basics 1

This chapter is designed to provide you with a basic understanding of the features and
functions of your product. Included are definitions of a few key NetBackup terms to assist
you in this process.

Installing NetBackup software on the server and NetBackup client software on each of
your remote computers provides an easy-to-use, reliable solution for backing up and
restoring data.

How does NetBackup work?

NetBackup has three primary functions:
¢ Enables administrators to create backup policies to back up data.
¢ Saves backup catalogs and stores the data until you need to retrieve it.

¢ Retrieves stored data while providing a robust recovery tool should a disaster occur.

What is a backup policy?

A backup policy allows you to configure how and when backups are to be performed for
your group of clients, all having similar backup requirements. You can configure your
backup policy after you have determined the following:

¢ Which computers to back up

Which files and folders to back up

How often and when the backup shall take place
How long the backup shall be retained

Where the backups are stored

* 6 6 o o

Other attributes for customizing the backup




How does NetBackup work?

What are catalog backups?

NetBackup keeps vital information about your (regular) backups in a set of files called a
catalog. Catalogs contain information about configuration, status, errors, and the files and
folders that have been backed up. The catalog also keeps track of the location of the
backed-up data.

The binary catalog format is designed to improve the scalability and performance of
catalog access in NetBackup. The binary catalog format improves catalog performance for
browsing and searching on-disk catalogs, and in some cases, reduces the catalog file size.
The binary catalog format is written by NetBackup on all platforms except NCR and
Sequent. For more information about catalog formats, see the NetBackup System
Administration Guide, Volume I.

A catalog backup is a backup copy of the catalog, which is necessary for NetBackup
operations. For example, if a disk failure results in the loss of your catalog files, the easiest
way to recover is to restore the catalog from its backup copy. This copy allows you to
restore previously backed up data and resume your regularly scheduled backups. The
process of backing up a catalog is the same for either catalog format.

What are the functional parts of NetBackup?

The following subsections describe basic terms and features to increase your
understanding of how NetBackup works.

The following diagram shows the basic architecture of a NetBackup Enterprise Server
configuration. The following subsections describe each of the major pieces within this
configuration, the master server, media servers, and NetBackup clients.
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How does NetBackup work?

MetBackup
Master Serwer

Ma Baclkup
Media Servers

MetBackup Clients and Agent=s

Master Server

The master server is the computer where NetBackup server software is installed. There can
be only one master server per backup domain. The NetBackup master server is
responsible for the following functions:

¢ Contains the backup configurations and policies
¢ Runs the scheduler that initiates the automated backups

¢ Maintains databases/catalogs that track the location and contents of all backups
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¢ Communicates with media servers to initiate backups and restore processes

¢ Provides both a command line interface and a graphical user interface, allowing you

to:

L 4
L 4
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Configure the backup operations.

Schedule automatic, unattended backups (regular backups). For example, to
prevent interference with normal daytime operations, you can schedule your
automatic backups to occur only at night.

Perform manual backups of any client.

Allow client users to perform their own backups and restores.
Control where backups are stored.

Control how long backup data is retained.

Restore data to any client.

Run reports to verify, manage, and troubleshoot backups and restores. These
reports show status or highlight problems with NetBackup servers and clients.

Monitor the status of backup and restore jobs.

Configure and manage tapes and storage devices.

Media Servers

A media server, in a NetBackup Enterprise Server configuration, can be a standalone server
that receives requests for backup and restore operations from the master server. (A master
server can be configured as a media server as well.) There can be multiple media servers
in a backup domain. In a configuration using NetBackup Server software (not Enterprise
software), the master server and media server are the same host.

Media servers can:

4

Communicate with the Media Manager (on the same system) to select media for

backup and restore operations. Refer to “Media Manager” on page 6 for more

information.

Communicate with NetBackup clients during a backup or restore operation.

Monitor the status of storage devices.
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NetBackup Clients

NetBackup clients are the remote computers that have NetBackup client software installed.
A NetBackup Enterprise Server configuration can have a virtually unlimited number of
clients for each backup domain. With the proper conditions set, a client can direct a user
request to the master server to perform a backup or restore operation.

Clients can perform the following functions:
¢ Validate connection requests from the NetBackup server.
¢ Support compression of the backup stream.

¢ Support include and exclude lists (a list that indicates which files to include in a
backup and which files to exclude from a backup).

In general, NetBackup clients can be any combination of the following operating systems:
¢ AIX

HP-UX Tru64/Alpha

HP-UX 9000

Linux

Macintosh

Novell

Solaris

Windows NT/2000/XP (32 and 64 bit)/2003 (32 and 64 bit)

® & 6 6 6 o o

For a complete list of supported clients and corresponding version numbers, refer the
NetBackup Release Notes.

Storage Unit

A storage unit is a term that describes a storage device where NetBackup stores the files
and data that are backed up. A storage unit can be a location on a disk, a set of drives in a
robot, or one or more single tape drives of the same type that connect to the same media
server.

In the following screen, selecting GUI object in the tree displays the individual units in the
Details pane.
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J File Edit Yiew Actions Help

=10/x|

-[Bl Activity Manitor
= NetBackup Management

[]--- Reports

-8 Policies

#-(=] Storage Units

48 Catalog

[II---@ Host Properties

=24 Media and Device Management
=) Device Manitor

- Media

IZII--- Devices

- Access Management

Far Help, press F1

EREEIEEE

Configure Storage Devices
Define robots and drives,

Configure Yolumes
Irventory robots and define volurmes for use in standalone drives.

Configure the Catalog Backup

Specify how and when MetBackup configuration and catalog information is fo be
hacked up.

Create a Backup Policy
Define schedules for backing up data on a single client or a set of clients.

Import Images
This wizard will assist you in stepping through an import,

[Master Server: imhop  [Connected 4

Storage units simplify administration because once defined, NetBackup points to a
storage unit rather than to individual devices. For example, if a storage unit contains two
drives and one is busy, NetBackup can use the other drive without administrator

intervention.

Media

Media can be physical magnetic tapes, magnetic disks (also called removable media), or
optical disks. Media is where data is stored. Non-removable media commonly referred to
as hard disk shares is usually a directory on a hard disk.

Media Manager

Media Manager, which is part of NetBackup is the VERITAS software that manages the
robots, tape drives, and removable media. Media Manager primarily uses four tools:

¢ The Device Configuration Wizard guides you through device configuration.
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¢ The Volume Configuration Wizard, which guides you through volume configuration.

¢ The Media and Device Management graphical interface, which allows you to
reconfigure storage devices and volumes separately.

¢ The Device Monitor graphical interface, which displays any pending requests for
volumes and allows you to control and manage devices.

User Interfaces

The NetBackup Administration Console that is installed on a server is used for
configuring, scheduling, monitoring, and managing NetBackup.

#5torage Units - imhop - NetBackup Administration Console =181x|

J File Edit “iew Actions Help

|8 -[m[&@ % =X 5 =@

REEETEEE

EE‘, HetBackup Management
w-El Feports

[+ @ Palicies

(=] Storage Units

- Catalng

[]‘--ﬂ Host Properties
=3 Media and Device Managarment
- I53) Device Manitor

-l Media

[ -- Devices

E]--@ Acress Management

Far Help, press F1

imhop All Storage Units: 1
S imhop (Master Server) Harme | Storage Unit Type | Density | Murnber... | Rohat... | Robot ... | oOn Demand |
-] activity Monitor ([SJimhop-disk Disk fas

[Master Server: imhop  (Connected. 4

The NetBackup user interface (referred to as Backup, Archive, and Restore) that is
installed on a client can be used for starting backups, managing archives, and initiating
restores for that particular computer. The following figures are examples of both of these

interfaces.
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i Backup, Archive, and Restore - NetBackup - Backup: Server: imhotep Client: imhotep o |m]
Bile Edit Wiew Acfions Window  Help
@Select for Backup | B3 Select for Restore v | View Status | @ ‘
Backup: Server: imhotep Client: imhotep o |m]
= All Folders Contents of C:*,
— | B Narne | At | Size| Tirme Modified
: () ADOREAPP d-- 0 3/2/2001 9:23:.C
O 4lpha d--- 0 5/2/2003 8:42:2
— O eackup d-- 0 12/1/2000 4:57:
O corom d--- 0 12/1/2000 5.03;
-] o Metwark OCgoeL g 0 12/1/2000 4:57:
---D il Registry O Caoeluti d--- 0 12/1/2000 5:09:
-[] ) Svstem_State QoM - 0 12/1/2000 5:13;
doos d-- 0 12/1/2000 4:57:
O (0RyLIB d-- 0 12/1/2000 4:57:
O (EditPad d-- 0 9/19/2002 10:1¢
O3 hysnap d--- 0 7/15/2003 5:03:
O (JLocalization d--- 0 1/7/2003 1:22:2
O3 misc d--- 0 1/7/2003 10:47;
O Camultimedia Files d--- 0 12/1/2000 5:12;
O (C3Program Files d--r 0 &/27/2003 9:09;
I_, [FAPSFONTS d--- 0 6.'“18/?003 953,
4 13 4
Ready 4

N
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NetBackup Wizards

NetBackup provides the following wizards to assist you with installation and
configuration. Once you have completed your initial setup with the Getting Started
Wizard, the individual configuration wizards allow you to reconfigure devices, volumes,
catalog backups, and backup policies separately as needed.

Wizards

Getting Started

Configure Storage Devices
Configure Volumes

Configure Catalog Backup

Create a Backup Policy

Import Images

Configure a Shared Drive

Description

Provides step-by-step help for configuring NetBackup. By
responding to a series of prompts, the Getting Started Wizard
guides you through the following procedures for initial
setup:

+ Device Configuration

+ Volume Configuration

+ Catalog Backup Configuration
+ Backup Policy Configuration

+ A test to verify your configuration
Helps you define robots and drives.
Helps you define volumes for robots and standalone drives.

Helps you configure how and when the NetBackup catalog is
backed up.

Helps you configure regular backups for a client or a set of
clients.

Assists you in stepping through the import image process.

Helps you configure a new shared drive or reconfigure an
existing shared drive.

If you require any assistance while working through a wizard, you can click on the Help
button on any particular window in the wizard.
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Installation and Initial Configuration 2

This chapter discusses how to install and configure NetBackup. Depending on whether
you are installing for the first time on a master server, upgrading an existing version of
NetBackup, or installing NetBackup to a new client will require you to perform certain
procedures to accomplish your task. The following list identifies some of the processes

that you may need to perform to install, uninstall, or upgrade NetBackup.

¢ "Configuring Storage Devices for Windows," on page 12
¢ "NetBackup Installations,” on page 14

¢ '"Upgrading NetBackup," on page 51

¢ 'Installing Alternative Administration Interfaces," on page 65 (Optional)
¢ 'Uninstalling and Reinstalling NetBackup," on page 71

¢ "Configuring NetBackup Server Software," on page 77

¢ 'Installing NetBackup Client Software," on page 83

From the NetBackup installation CD, you can also install additional products that are
associated with NetBackup.

¢ NetBackup Tape Device Drivers

¢ NetBackup Advance Reporter (NBAR)

¢ NetWare Media Server

¢ Cluster Server Enterprise Agent for NetBackup

This link installs the Cluster Server Enterprise Agent 2.2 for NetBackup (for Windows
2000 or later). Information on using this agent is covered in the VCS Enterprise Agent
for NetBackup Installation and Configuration Guide.

Version 1.2.1 of the agent (for Windows NT) can be installed from the VCS Enterprise
Agent for NetBackup CD. Information on using this agent is covered in the NetBackup
High Availability System Administrator’s Guide.

The remainder of this chapter discusses the necessary steps to install NetBackup. For
specific installation procedures about a particular add-on product, refer to the
product-specific information associated with that product.
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Configuring Storage Devices for Windows

Reliable use of NetBackup depends on the proper configuration of your storage devices.
To ensure reliable backups and restores, you must configure devices for Windows
according to the instructions provided by the device vendor and by Microsoft. Storage
devices should be installed and configured before you configure NetBackup.

Caution An improperly configured device may lead to loss of data during a restore.

Supported Robot Types

A list of the supported robot types, organized by vendor and platform, can be found in the
NetBackup Release Notes for UNIX and Windows. This list contains those devices that are
supported at the time of this release. However, VERITAS periodically adds new robots to
this list. For your convenience, VERITAS posts updates to the supported robots lists on the
VERITAS Support web site. The following procedure will assist you in locating the most
current support information.

To find the latest devices this release supports

1. Open www.support.veritas.comin a web browser.

2. Select NetBackup in the Product Family list.

3. Select a product in the Select Product list.

4. Click the Compatibility tab.

5. Select the Product Version, Platform, and Language from the appropriate drop-down
menus.

6. Click Go. All compatibility-related files will appear.
7. Click Device and Library Compatibility Information - All Versions and Platforms.

8. Anew web page appears, and enables you to select the product level that you want to
reference. Select an appropriate product level.

9. From this page you can choose to view device support information by individual
vendor, or all support drives, libraries, or robot types.
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Storage Device Configuration

First, complete all of the configuration steps specified by the storage device vendor and by
Microsoft. After you have configured your storage device you are ready to begin the
installation of the NetBackup software.

Note When installing NetBackup for the first time, VERITAS recommends that you install
the latest device drivers for your storage device immediately after you install the
NetBackup software and before you configure the product.

If you are upgrading NetBackup, you can install the latest device drivers before you
upgrade NetBackup.

The VERITAS Tape Device Driver Install wizard (located on the NetBackup
installation CD) steps you through the process of installing the latest device drivers.
The steps below describe how to initiate this wizard.

If you do not have a CD, you can download the NetBackup Tape Device Driver
Install software from the VERITAS Support web site:

http://www.support.veritas.com

¥ To initiate the Tape Device Driver Install wizard
1. Log on as Administrator on the server where you will be installing NetBackup.

2. Insert the NetBackup CD in the drive.

¢ On Windows systems with AutoPlay enabled for CD-ROM drives, the VERITAS
NetBackup installation browser starts automatically.

¢ On Windows systems that have AutoPlay disabled, run Launch.exe in the
top-level directory on the CD.

3. Inthe VERITAS Browser, click the Additional Product Installations > NetBackup
Tape Device Driver link. The NetBackup Tape Installer wizard appears.

4. Follow the prompts throughout the wizard to install the latest device drivers for your
storage device.

Note As VERITAS supports more devices, you can download the latest external device
mapping files on the Updates and Patches web page on the VERITAS Support web
site: http://www.support.veritas.com.

5. After you complete this installation, configure the NetBackup software.
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NetBackup Installations

This section prepares you for the installation of your NetBackup product by providing
system requirements, license key information, and step-by-step instructions on:

¢ "NetBackup Server Installation Requirements," on page 14

¢ 'Installing NetBackup Server Software," on page 17

¢ "Customizing a NetBackup Installation," on page 25

¢ '"Remotely Installing NetBackup," on page 29

¢ 'Installing NetBackup in a Clustered Environment," on page 36
¢ 'Installing NetBackup Silently," on page 48

By definition, your NetBackup server is also a NetBackup client. When you installed the
NetBackup server software, both the NetBackup server and NetBackup client software
were installed on the server.

For more information on installing NetBackup client software, refer to “Installing
NetBackup Client Software” on page 83.

NetBackup Server Installation Requirements

Installing the server software takes approximately 10 minutes (additional time may be
required to set up the product for your environment). Before installing, note the following
requirements:

Caution Before installing your NetBackup product, make sure you have the most
current operating system patches and updates applied to your system. If you
are not certain of your operating system level, contact your operating system
vendor and request the latest patches and upgrades.

Note It is important that you ensure all NetBackup servers have a release level installed
that is at least equal to the version level installed on the clients. (Older versions of
server software can encounter problems with newer clients.)

Requirements for Local Installations

The following list identifies requirements and notes to ensure you are able to install
NetBackup without error.

¢ Remove any other vendor’s backup software currently configured on your system
before installing NetBackup. The backup software of another vendor can negatively
affect how NetBackup installs and functions.
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¢ System configuration necessary to install NetBackup on a Windows-based server:

4

4

4

An Intel Pentium system running Microsoft Windows NT version 4.0 with service
pack 6A installed, Windows 2000 with a minimum of 64 MB of memory and
service pack 2 installed, or Windows 2003 server.

Requires a minimum browser level of Internet Explorer 5.0 for NetBackup and
Internet Explorer 5.5 for NetBackup Global Data Manager (GDM).

The minimum screen resolution configuration is 1024X768 256 colors.

¢ An administrator account and password for the server.

¢ Adequate disk space: VERITAS recommends that you have a total of 575 MB of
storage space to accommodate the NetBackup server software and NetBackup
catalogs. The following items provide a basic itemization of the disk space
requirements.

*
*
*

*

Intel server software requires approximately 250 MB.
On-line documentation, if you choose to install it, requires about 85 MB.

NetBackup catalogs contain information about your backups and will increase in
size as you use the product. The amount of disk space the catalogs require
depends primarily on the number of files backed up, the frequency of your
backups, and the amount of time you chose to retain your backup data. VERITAS
suggests that you allow a minimum of 250 MB.

An additional 500 MB of disk space is necessary on the drive where Windows is
installed during the upgrade process. After the upgrade is complete, this
additional space is no longer needed.

A NetBackup installation partition that supports long file names. VERITAS
suggests an NTFS partition.

¢ Peripherals, such as robotic devices and stand-alone tape drives, installed according
to the manufacturers’ instructions and recognized by the Windows software.

¢ The network is configured so the computers recognize and communicate with one
another. Generally, if you can reach the clients from the server by using the ping
command, the setup will work with NetBackup.

¢ NetBackup Server Installation Notes

*

NetBackup Services and Port Numbers

VERITAS suggests that you use the default port settings for NetBackup services
and Internet service ports. If you modify the port numbers, they must be the same
for all NetBackup systems that communicate with each other (that is, all master
servers, media servers, and clients). The port entries are in the following file:

%$SYSTEMROOT%\system32\drivers\etc\services
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*

To change the default settings, you must perform a Custom Installation of
NetBackup.

& Client Software

Installing NetBackup server software also installs client software on the server
system. However, installing NetBackup on client systems is done separately. Refer
to “Installing NetBackup Client Software”.

¢ System Names

If you install NetBackup Remote Administration Consoles, the master server
must have the system names of the NetBackup Administration Consoles in its
server list to allow them access.

Additional Notes (for NetBackup Enterprise only)

¢ For instructions on verifying and changing the server list, and installing media
servers, refer to the NetBackup System Administration Guide for Windows, Volume I.

¢ If you are not adding any NetBackup media servers, ignore all references to
media servers throughout the installation process.

Additional Requirements for Remote and MSCS Cluster Installations

In addition to the local installation requirements, the following points apply to remote
and cluster installations:

4

The source PC (or primary node) must have Windows NT, Windows 2000,
Windows XP, or Windows 2003 server installed. (Windows XP does not apply to
clusters.)

The destination PC (or clustered nodes) must have Windows NT, Windows 2000,
Windows XP, or Windows 2003 server installed. (Windows XP does not apply to
clusters.)

The person performing the remote or clustered installation must have administrator
privileges on all the remote PCs or nodes in the cluster. VERITAS recommends that
the person performing the installation keeps a record of all nodes included in the
cluster. This list may become important when remembering which nodes to upgrade
or uninstall.

All clustered nodes must be running the same operating system, service pack level,
and version of NetBackup. Mixing server versions is not supported in a clustered
environment.

Additional Requirements for Access Controlled Environments

The Authorization broker must reside on the master server.
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NetBackup License Key Requirements

When installing a NetBackup master or media server, you must enter a NetBackup base
product license key during installation. Check your order to make sure that you have
license keys for all the NetBackup servers, clients, options, and agents that you requested.
During the installation process you will also be given an opportunity to enter your
remaining license keys. Because all product license keys must be entered on the master
server, VERITAS recommends that you enter all of your product license keys at this time.

For more information about license keys, refer to chapter 8, "NetBackup License Keys," on
page 105. For detailed information on how to administer NetBackup license keys, refer to
the NetBackup System Administration Guide for Windows, Volume I.

Installing NetBackup Server Software
This section describes how to perform a basic installation of NetBackup server software.
When installing NetBackup for the first time, VERITAS recommends that you install
NetBackup in the following order:
1. Master servers
2. Media servers, if any (NetBackup Enterprise Server only)
3. NetBackup Remote Administration Console, if any
4. NetBackup clients
5. Any NetBackup Add-on products (such as GDM or NBAR)

v To install NetBackup server software

1. Log on as Administrator on the server where you will be installing NetBackup.

2. Insert the NetBackup installation CD in the drive.

¢ On Windows systems with AutoPlay enabled for CD-ROM drives, the VERITAS
NetBackup installation browser starts automatically.

¢ On Windows systems that have AutoPlay disabled, run Launch.exe in the
top-level directory on the CD.
3. The NetBackup browser displays the following information and options:

¢ Links on the left side of the browser that display information relating to
NetBackup, Database Agents, and Additional Products.
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¢ Browse the CD
¢ The NetBackup link selected (by default) and these available options:
¢ Begin NetBackup Installation
¢ View available documentation
¢ Link to VERITAS Technical Support
¢ Link to VERITAS e-Learning

23Vl VERITAS

—_— NetBackup™
for Windowse

NetBackup Installation
View Documentation

Additional Products
VERITAS Technical Support
VERITAS eLearning

Gowsecd )
VERITAS US home

™
2%
=

4. Click NetBackup Installation.The browser now displays pre-installation information.
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VE RTTA § VE RITAS
NetBackup™

for Windowse

Pre-Installation Information

= Check YERITAS Web Site for Product Alerts

Install Server Software

Additional Products = View Server README

Install Client Software

= Wiew Client READWME

Install Java Windows Display Console

VERITAS US home

Back

m
=

5. Click Install Server Software. A welcome window appears informing you that the
NetBackup setup wizard is about to install the software on your system.

6. Click Next.

7. To proceed with the installation, you must check the I accept the terms of the license
agreement option, then click Next.

8. Select Install to this computer only and click Next to perform a local installation.

Chapter 2, Installation and Initial Configuration 19 -



NetBackup Installations

2 VERITAS NetBackup

MetBackup Installation Type

Select where you want to install MetB ackup V E R ] TA Sw

" Select from available computers on the netwark,

" Berform a clustered install of NetB ackup,

If wou choose the "Select from available computers on the network" option, Setup will scan your
hetwark for available spstams.

< Back I Mest > I Cancel |

9. On the NetBackup License Key and Server Type window, enter the base product
license key that you received when you purchased your product. The license key
determines which installations are available to install. For example, the NetBackup
Media Server option is only available with NetBackup Enterprise Server.

B\ VERITAS NetBackup

MetBackup Licenze Key and Server Type

™
Enter your NetB ackup licenze key and select the type of V E R ] TA S
MetBackup installation to perform.

Licenze Key CEME-DRPN-2PPR-Fw0P-6ZPC-PRCP-PIFP-3402-F

MetBackup Master Server
@ Install & b aster Server. At least one Mazter Server iz required for NetBackup to
properly function.
HetBackup Media Server
Install a Media Server. & MetBackup Master Server iz required for the Media Server to
praperly function.
MetBackup Remote Administration Console

Install 2 Remote Administration Conzole. The Femote Administration Console dlows
woul ta remately administer any number of MetBackup Servers from one location.

Licenze Tupe: MetBackup Enterprise Server
Expiration Date: Thursday, July 31, 2004

< Back | Tents | Cancel |

10. Select the type of installation that you want to perform.
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Note Installing the NetBackup Remote Administration Console does not require a license
key.

11. Click Next. The Setup Type wizard appears. You can elect to perform a typical or a
custom installation. Refer to “Customizing a NetBackup Installation” on page 25 to
see the differences in the installation processes.

12. Select Typical and then click Next.

In the NetBackup System Names window, enter the names of the other systems that
are allowed to access this server.

Note NetBackup Enterprise only: If installing a media server, the NetBackup System Names
window will have an additional line with the local media server filled in. You must
enter the name of the master to which the media server is configured.

13. Enter the server names and click Next. The NetBackup Global Device Database Host
window appears.

14. This step applies only to NetBackup Enterprise.

Enter the name of the NetBackup Global Device Database Host, which serves as the
repository for global device configuration information.

By default, the Global Device Database host is the master server currently being
installed. Under most circumstances, this can be left as the default. However, you may
need to enter a different host name in the following situations:

¢ If the system shares drives with the Shared Storage Option (SSO), all NetBackup
servers must use the same host for storing device information.

¢ If the system has multiple master servers, enter the name of the server that will
store the global device configuration information. Conflicting host information
may result in an error.

For more information, refer to the NetBackup Media Manager System Administrator’s
Guide for Windows.

Note To make changes to the installation settings, click Back until you reach the page you
want to change, or click Cancel and exit the wizard.
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B\ VERITAS NetBackup

MNelBackup Global Device Database Host w
™
Enter the name of the haost that will store global device V E R ] TA S
information and your preferred authorization group.

For most inzstallations, the global device database host name can remain the same as
the Master Server Name.

Global Device D atabase Host Mame: IithtEP

< Back I Mext > I Cancel |

15. Click Install. The installation process begins. This process could take several minutes.

Note After the installation completes, a NetBackup installation log file is generated and
placed in your default TEMP directory. The following procedures explain how to
verify the location of your TEMP environment variable.

v To locate the NetBackup installation log file for Windows 2000, XP, and 2003
systems

a. Select Start > Programs > Accessories > Command Prompt. A Command Prompt
window appears.

Note Make sure you can view all hidden files and folders. To set this option, select Tools
> Folder Options.... in the Control Panel window; click the View tab; select the
Show hidden files and folders option; and click OK.

b. Enter echo %TEMP% and press the Return key on your keyboard. The location of
your TEMP directory will display.
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v To locate the NetBackup installation log file for Windows NT systems

a. Select Start > Settings > Control Panel. The Control Panel window appears.

Note Make sure you can view all hidden files and folders. To set this option, select View
> Folder Options... in the Control Panel window; click the View tab; select the
Show All Files option; and click OK.

b. Double-click the System icon. The System Properties window appears.

c. Click the Environment tab. The Environment Variables, including the TEMP
variable, appear along with the corresponding paths for each variable.

16. Prior to clicking Finish, the NetBackup installation prompts you to enter additional
license keys or complete the installation and continue the setup process by
configuring your NetBackup product. By default the Launch NetBackup
Administration Console now check box is selected.

a. To enter additional license keys, click Add Keys.

b. To complete the installation and configure your product, click Finish. For more
information on how to configure your product, see “Configuring NetBackup
Server Software” on page 77.

c. To complete the installation and wait to configure your product at another time,
clear the Launch NetBackup Administration Console now option, then click
Finish.

Note VERITAS recommends that you continue with the product setup and configuration
by clicking the Getting Started link in the details pane of the NetBackup
Administration Console and continuing through this wizard until you have
completed the production configuration.

v To install NetBackup Access Control on your NetBackup system
1. Successfully install NetBackup. Perform Steps 1 - 16 in the previous procedure.

2. [Install the VERITAS Security Services (VxSS) components on your system so that you
are then able to use Access Control. (The VXSS components reside on another CD in
the NetBackup package.)

NetBackup Access Control can be turned on and run at any time after you have
installed or upgraded to NetBackup 5.1. After you have installed or upgraded to
NetBackup 5.1, you can run NetBackup Access Control by configuring VxSS and

———
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using the NetBackup Access Control features in the host properties dialog. For more
information about this, refer to VERITAS Security Services™ Version 4.0 Administrators
Guide for Windows and UNIX and the NetBackup System Administrator’s Guide,

Volume 11.

The VXSS components reside on a clearly marked CD in your NetBackup Product
package. The following table contains the VxSS components that you must install as
they apply to each NetBackup system, and after you have successfully installed
NetBackup.

NetBackup System Required VERITAS Security Services (VxSS) Components

NetBackup Master server Authentication client and server components

Authorization client and server components

NetBackup Media server Authentication client components

Authorization client components

NetBackup Client Authentication client components

Note If you want to perform a cross-platform authentication with Windows
platforms, you must install an authentication broker on a Windows system. For
instructions on how to install an authentication broker, refer to the VERITAS
Security Services™ Version 4.0 Administrators Guide for Windows and UNIX.

After you have finished installing NetBackup and the VXSS components applicable to
the type of NetBackup system you are installing to, you will be ready to configure the
access control features. For detailed information on how to configure Access Control,
refer to the NetBackup System Administrator’s Guide, Vol I1.
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Customizing a NetBackup Installation

While installing NetBackup, you can choose between performing a typical or a custom
installation. The typical installation uses predefined values and parameters. The custom
installation enables the user to make modifications to specific parameters. This section
briefly explains the changes that can be made during a custom installation.

A custom installation is identical to a standard installation until Step 10 in the previous
procedure. Then in the Setup Type window select the Custom.

¥ To customize a NetBackup installation

1. From the Custom Setup window you can:
& Select which features are installed, such as:
¢ NetBackup (And NetBackup publications)
¢ VERITAS SnapShot Provider
¢ NetBackup Debugger Symbols
¢ Change the installation location of the NetBackup product.

Note You cannot change the installation location on a remote install. NetBackup uses
the existing location of a previous install (or the system default location if there
was no previous install). In addition, you cannot change the installation
location on an upgrade or a new installation when using the system default
settings.

Note By default, the NetBackup Debugger Symbols features are marked not available
on initial installation.

Chapter 2, Installation and Initial Configuration 25 T



NetBackup Installations

a. Select the drop-down icon next to the feature that you want to change. A pop-up
window appears.

[ VERITAS NetBackup
Custom Setup =

Select the program features you want ingtalled, V E R ] TA S~

Click on an icon in the list below to chahge how a feature is installed.

- Feature Description

(= + | VERITAS Snapshot Provider
- % ~| NetBackup Debugaer Symbals

Space Required 5 MB
Space Available 218 MB
YERITAS NetBackup will be installed in the following folder:
) Change... |
C:A\Pragram Files\WERITAS

< Back I Nest» I Cancel |

b. Click This feature will not be available. A red “X” appears in the icon signifying
the feature will not be installed.

c. Click Change to select a new location to install NetBackup. The Change Current
Destination Folder window appears. This window enables you to browse to a
new location and designate a new folder where NetBackup will be installed.

2. Click Next.

From the NetBackup Services window you can:

¢ Enter a Username, Password, and Domain or check the Use the built-in system
account check box.

¢ Choose a startup type to use for the NetBackup services.

¢ Elect to start the services after installation by checking the Start NetBackup
Server Services After Install check box.
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B\ VERITAS NetBackup

HetBackup Services

Chooze the username and pazsword and the startup type to be uzed for the
MetBackup services.

v Use the built-in system account

Usemame I

Pazsword I

Domain— [IMHOTER |

Startup:
’7 & Automatic € Marual

[V Start MetBackup Server Services After Install

< Back I Mest » I Cancel |

3. Click Next. The NetBackup Port Numbers window appears.

This window enables users to change port numbers if that is necessary. The following
are reasons why a user may want to change a port number:

¢ A conflict exists between NetBackup and another industry product sharing the
same port.

¢ A port conflict occurs with a company’s firewall causing security issues.

B\ VERITAS NetBackup
HetBackup Port Humbers

VERITAS"

Enter the part numbers for the following NetB ackup Processes and Services. The port
numbers do not need to be modified except under unusual circurmstances.

bpcd wad  [13703 mied  [13718
bprd IW tldcd IW vopied IW
bpdbm  [13721 Had EEN aed 138
wmd  [1I00 wdd  [1EE briobd  [13723
acsd  [1I02 thd  [13715 nbdbd  [13784
tged 13705 td 13716 werd  [1372¢
odd  [13708 thed 13717 visd 5284
Default Ports | < Back IWI Cancel |
A4
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4. Click Next. The NetBackup System Names window appears.

5. Enter the name of the current server and then enter the names of the other systems
that are allowed to access this server. From the dialog, you can list each server on a
separate line or in a comma-delimited list.

6. Click Next. The NetBackup Global Device Database Host window appears.

7. Enter the Global Device Database Host Name and click Next. The Ready to Install
the Program window appears.

Note If you want to make changes to the installation settings, click Back until you reach
the page you want to change, or click Cancel and exit the wizard.

8. Click Install. The installation process begins.
9. At the end of the installation, the Completing the NetBackup Setup wizard window
appears and enables you to add additional NetBackup license keys.

In addition, if you elected to start the NetBackup services during the install process,
then the Launch NetBackup Administration now check box will be checked.

I NetBackup Setup ]

Completing the NetBackup Setup wizard @

The NetBackup Setup wizard has successfully instaled NetBackup, Click Finish to exit the
Sefup wizard.

V' Launch NetBackup Administration Corsols now,

Click Add Keys to add additional NetBackup license keys.

You must reboat your computer before VERITAS Snapshot Provider will be enabled.

In order for IDR and VYSP to be activated for backups, you must enter an appropriate
license key on your NetBackup Master Server,

Your administrator may have to change permissions on C:...\ for backups to be successful.

Imstalstield

< Back Einish Caneel

10. Click Finish.
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The NetBackup Administration Console opens. For more information about
NetBackup and its functionality, refer to the NetBackup System Administrator’s Guide for
Windows, Volumes I and II and the NetBackup Media Manager System Administrator’s
Guide for UNIX and Windows.

Remotely Installing NetBackup

This procedure enables you to install NetBackup master server software, media server
software, or the Remote Administration Console to multiple Windows systems from a
single Windows system.

Note Review the installation requirements for NetBackup on page 14 before starting this
procedure.

Follow these instructions to install the NetBackup software on selected Windows NT,
Windows 2000, Windows XP, or Windows 2003 servers in your network (one of these
systems can be your local system). You may stop the installation process at any time by
clicking Cancel.

Notes on Remote Installations

¢ You must have administrator privileges on the remote server for the NetBackup
installation to complete successfully.

¢ The NetBackup server setup program cannot clean up an aborted install. Therefore, if
you stop Setup while it is copying files to a client, the files that have been
successfully installed are not uninstalled.

Vv To install NetBackup on remote computers
1. Log on as Administrator on the server where you will be installing NetBackup from.

2. Insert the NetBackup installation CD in the drive.

¢ On Windows systems with AutoPlay enabled for CD-ROM drives, the VERITAS
NetBackup installation browser starts automatically.

¢ On Windows systems that have AutoPlay disabled, run Launch.exe in the
top-level directory on the CD.
3. The NetBackup browser displays the following information and options:

¢ Links on the left side of the browser that display information pertaining to
NetBackup, Database Agents, and Additional Products.

& Browse the CD
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¢ The NetBackup link selected (by default) and these available options:
¢ Begin NetBackup Installation
¢ View available documentation
¢ Link to VERITAS Technical Support
¢ Link to VERITAS e-Learning

4. Click NetBackup Installation. The browser refreshes and displays pre-installation
information.

5. Click Start NetBackup Server Installation.

6. To proceed with the installation, you must check the I accept the terms of the license
agreement option, then click Next.

7. Select the Select from available computers on the network option and click Next to
install NetBackup to remote systems.

B\ VERITAS NetBackup ]

MetBackup Installation Type -
Select where you want to install MetBackup V E R ] TA va-

= Install ta this computer only.

' Eelect from available computers on the network

| Berform a clustered install of HetBackup,

If you choosge the "Select from available computers on the network" option, Setup will scan your
network for available systems.

< Back I Mest » I Cancel |

8. Enter the base product license key that you received when you purchased your
product. During this installation process, the following occurs to ensure you have
proper credentials to perform remote installations:

¢ If you are installing for the first time on the host system, you will need to enter a
valid license key.

¢  When performing an upgrade, no license key is required. Your current license key
will be used.
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¢ After you select a remote system to install to:

¢ NetBackup determines if you have proper administration credentials on that
system. If you do not have the proper credentials the system is not added to
the list.

¢ If you do have the proper credentials, NetBackup performs a second check
and determines if a license key is needed. If a license is needed and one was
not entered, the system cannot be added to the list. You must enter a valid
license key to install to that remote system.

¢ If you enter an invalid license key, the NetBackup License Key and Server Type
screen will remain visible until a valid key is entered.

The license key that you enter determines which of the three installations are available
for you to install. For example, a NetBackup Enterprise Server key will enable all
installation choices as shown in the following figure. Entering a NetBackup Server
key means the NetBackup Media Server installation choice is not available.

B\ VERITAS NetBackup
MetBackup License Key and Server Type -

™
Enter your MetBackup license key and select the type of V E R ] T A S
MetBackup installation to perform.

License Key CEME-DRPH-2PPR-3w0P-6ZPC-PRCP-PIPP-340Z-H

MetBackup Master Server

% Install a Master Server. At least one Master Server iz required for MetBackup to
properly function.

MetBackup Media Server

Install a Media Server. & MetBackup Master Server iz required for the Media Server to
properly function.

MetBackup Remote Administration Console
Install & Remote Administration Console. The Remate Administration Console allows
you to remately administer any number of MetBackup Servers from one location.

Licenze Type: MetBackup Enterprise Server
E=piration Date: Thursday, July 31, 2004

< Back | Tewt > | Cancel |

9. Select the type of installation that you want to perform.

Note Installing NetBackup Remote Administration Console does not require a license
key.

10. From the Setup Type window, you can elect to perform a typical or a custom
installation. Refer to “Customizing a NetBackup Installation", on page 25” to see the
differences in the installation processes.
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11. Select Typical and click Next. The NetBackup System Names window appears.

From this window you can enter the names of the systems that will have access to this
current system. During a remote upgrade the following applies:

¢ You cannot change the installation location on a remote install. NetBackup uses
the existing location of a previous install (or the system default location if there
was no previous install). In addition, you cannot change the installation location
on an upgrade or a new installation when using the system default settings.

¢ The master server name will not change even if you are pushing an upgrade to
servers with other masters.

& NetBackup Enterprise only: If installing a media server, the NetBackup System
Names window will contain an additional line with the local media server filled
in. You must enter a master server name for the NetBackup Administration
Console and the Remote Administration Console that this media server is
configured to.

[l YERITAS NetBackup |

NetBackup System Names -

Itiz highly recommended that you enter the names of all the V E R ] TA S i
zervers you will be ingtalling in the additional servers field.

Master Server Mame: GUAC

Additional Servers: Culf ;I
cul

|

< Back I Mest > I Cancel |

12. Enter additional server names and click Next. You can cut, copy, or delete a server
from the list by selecting a server and using the right mouse button functionality.

Note All destination servers systems share the same server list.

13. From the NetBackup Global Device Database Host window, choose a device database
setting and click Next. This window enables you to choose which device database
settings you want to install on the destination servers that do not have NetBackup
installed. Servers that already have NetBackup installed will retain their current
Global Device Database Host setting.
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Note The NetBackup Global Device Database Host window only appears for master and
media server installations.

B\ VERITAS NetBackup ]

MNetBackup Global Device Database Host -
Select the method for setting the Global Device Databaze V E R ] T A S :
Host on the remate spstems

The zettings you specify here will be applied only to remote systems that do not already have a
MetBackup server ingtalled. Remate spstems which do already have a MetB ackup server
installed will retain their existing Global Device D atabase Host setting.

& Distributed Device Datab

Each spstem that will be installed will be its own Global Device Database host.

¢ Common Device Database

Each spstem that will be installed will share the Global Device Databaze host that
you will specify in the next dialog box.

< Back I Mest » I Cancel |

14. In the Install NetBackup to remote systems window, select the servers from the list of
Available Systems and add them to the Destination Systems list. You are choosing the
systems that you want to remotely install NetBackup on. Each time you choose a
system, NetBackup performs the following system and license checks:

¢ Verifies the system for a server install that matches the type that you selected. If
the system does not have NetBackup installed, it is considered verified. If the
system already has NetBackup installed, the installation type on that system is
compared to the installation type that you are requesting. If you are requesting an
invalid combination (for example, trying to install a Remote Administration
Console on a system that already contains master server software) you will be
notified of this and the selection of that system is disallowed. In addition, if the
remote system is at a platform level of Windows ME or less, or a 64-bit Windows
system, the install is disallowed.

¢ Verifies that you have proper administration credentials on the remote system
that you chose. If you do not have administration credentials, the Enter Network
Password window appears and prompts you to enter the administrator’s user
name and password. Click OK, and continue selecting destination systems.

Note This process repeats for each server that you select. In addition, you can elect to
remember the user name and password and only be prompted when the user name
or password is not valid on a particular system.
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B\ VERITAS NetBackup

Install MetBackup to remote systems -

Select MetBackup destination systems. V E R ] TA va-

Right click on ‘Awailable Systems' tree items for more options.

Awailable Spstems Destination Systems

ICARUS =l
D&
IDUN

INJECTOR _>|
INTEGH-TANILM!

INTERCOOLER

IRON it ;l
ISHTAR

L

JAGUAR

JDENISON-W2K

JP3
JROGW2K, =l

MINDY
------ =) IMHOTEP

< Back I Mest » I Cancel |

15. Click Next when you have finished selecting remote systems.

16. On the Ready to Install the Program screen, click Install.

B\ VERITAS NetBackup ]

Ready to Install the Program -

The wizard iz ready to begin installation. V E R ] TA va-

Click install to begin the installation of the MetBackup Master Server.

If you want to review or change any of your installation settings, click Back.
Click Cancel to exit the wizard.

< Back I Inztall I Cancel |

Note You may need to reboot the remote systems after the installation is complete.

A summary screen appears that displays the progress of the installation on each of the
systems. You can right-click on a system listed in the screen to see a status of the
install. This is useful, for example, to see if an install failed on a particular system. You
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would then be able to obtain more information about the failure by viewing the
remote install log. The remote install log is named nbpinst.log and is located in
the Windows installation directory.

17. Click Finish. The remote install is complete and NetBackup is now running on your
remote system.
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Installing NetBackup in a Clustered Environment

This procedure explains how to install NetBackup master server software or media server
software in a clustered environment to multiple Windows systems from a single Windows
system. Review the installation requirements for NetBackup on page 14 before starting
this procedure.

Follow these instructions to install the NetBackup software on selected Windows NT,
Windows 2000, or Windows 2003 servers on the active node in your clustered
environment. You may stop the installation process at any time by clicking Cancel.

Note The NetBackup server setup program cannot clean up an aborted install. Therefore,
if you stop Setup while it is copying files to a client, the files that have been
successfully installed are not uninstalled.

To prepare to install NetBackup in a clustered environment

1. When installing NetBackup in a clustered environment you must first perform the
following actions:
¢ If installing NetBackup in a MSCS cluster:

¢ The shared disk to be used by the NetBackup Group must already be
configured in the cluster and online on the active node to install.

¢ Install NetBackup from the active node.

¢ Take all of the NetBackup group resources offline except for the disk. Refer to
the Microsoft Administration documentation to determine how to take the
NetBackup group resources offline using the Cluster Administrator interface.

¢ If installing NetBackup in a VCS cluster, you must first freeze the active node so
that migrations will not occur while the inactive nodes are being installed. If you
have a VCS cluster configured, you can freeze the active node using the Cluster
Manager interface, or the command line.

2. After you take the cluster offline bring the shared disk back online (for MSCS clusters)
or freeze the active node (VCS clusters). You are now ready to begin the installation
process. Perform the procedure, “Installing NetBackup in a Clustered Environment.”

To install NetBackup in a clustered environment

1. Log on as Administrator on the active node. The active node is the node that owns the
disk that will be used as the NetBackup shared disk.

2. Insert the NetBackup installation CD in the drive.

v
v
—
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¢ On Windows systems with AutoPlay enabled for CD-ROM drives, the VERITAS
NetBackup installation browser starts automatically.

¢ On Windows systems that have AutoPlay disabled, run Launch.exe in the
top-level directory on the CD.

3. The NetBackup browser displays the following information and options:

¢ Links on the left side of the browser that display information relating to
NetBackup, Database Agents, and Additional Products.

& Browse the CD

¢ The NetBackup link selected (by default) and these available options:

*

*
*
*

Begin NetBackup Installation

View available documentation

Link to VERITAS Technical Support
Link to VERITAS e-Learning

4. Click NetBackup Installation. The browser refreshes and displays pre-installation
information.

5. Click Start NetBackup Server Installation.

6. To proceed with the installation, you must check the I accept the terms of the license
agreement option, then click Next.

7. This step applies only to MSCS clusters: Select Perform a clustered install of
NetBackup, then click Next.

Note The installation process references the registry settings of your system to determine
if your system is configured for a Windows MSCS clustered environment. If your
system is configured for a MSCS clustered environment, the Perform a clustered
install of NetBackup option will be available for selection.
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f] YERITAS NetBackup x|
MetBackup Installation Type -
Select where you want to install MetBackup V E R ] TA S )

= Install ta this computer only.

" Select from available computers on the network

' Perform a clustered install of MetB ackup.

If you choosge the "Select from available computers on the network" option, Setup will scan your
network for available systems.

< Back I Mest > I Cancel |

8. Enter the base product license key that you received when you purchased your
product. During this installation process, the following occurs to ensure you have
proper credentials to perform remote installations:

¢ When you select a clustered system to install on, NetBackup determines if you
have proper administration credentials on all nodes in the cluster. If you do not
have the proper credentials the system is not added to the list.

¢ If you enter an invalid license key, the NetBackup License Key and Server Type
screen will remain visible until a valid key is entered.

¢ The license key that you enter determines which of the installation options are
available for you to install.
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B\ VERITAS NetBackup
MetBackup License Key and Server Type

™
Enter your MetBackup license key and select the type of V E R ] T A S
MetBackup installation to perform.

License Key CEME-DRPH-2PPR-3w0P-6ZPC-PRCP-PIPP-340Z-H

£

b

L

Licenze Type: MetBackup Enterprise Server
E=piration Date: Thursday, July 31, 2003

MetBackup Master Server

Install a Master Server. At least one Master Server iz required for MetBackup to
properly function.

MetBackup Media Server
Install a Media Server. & MetBackup Master Server iz required for the Media Server to
properly function.

HetBackup Bemote Administration Console

Inztall & Femate &dministration Console. The Bemate Administration Consale allows
you ko remotely administer any number of HetBackup Servers fram one lacation,

< Back | Tewt > | Cancel |

9. Select the type of installation that you want to perform.

From the Setup Type window, you can elect to perform a typical or a custom
installation. Refer to “Customizing a NetBackup Installation” on page 25 to see the
differences in the installation processes.

10. Select Typical and click Next.

11. In the Cluster Settings window, enter the appropriate data in each of the fields. These
fields are listed below along with a brief description of each field.

4

NetBackup Cluster Group Name: A name used to identify a NetBackup service
group or resource group. A resource group is comprised of resources that are
related and interdependent to each other.

Virtual Host Name: The name of the cluster as known by the NetBackup
environment. This is the name that will be entered in the client server list. It is also
the name that the server uses when communicating to the client nodes.

Virtual IP Address: This is the IP address of the cluster. The address to which the
virtual server name should resolve.

Subnet Mask: A mask used to identify a subnetwork so that IP addresses can be
shared on a local area network. This number correlates directly to the virtual IP
address of the cluster.

Path to Shared Data: This path indicates a directory on one of the shared disks in
the cluster where NetBackup stores configuration information.
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¢ Public Network - When installing NetBackup on a clustered system, choose one
of the public networks assigned to the node of the cluster.

Caution You must not select the private network assigned to this cluster.

[ YERITAS NetBackup

Cluster Settings

Enter the parameters to be used by MetBackup in thiz

clustered environment.

VERITAS"

MetBackup Cluster Group Mame

Yirtual Host Mame

Yirtual P Address

Subnet Mask

Fath to Shared Data

Public Metwark

INetB ackup Master Server Group

|QUAE

|1D.80.13?.3

|255.255.255. [

IY:\Program Filezhweritaz j

| [~

x|

< Back I Mest > I Cancel

12. Click Next. The NetBackup System Names window appears.

From this window you can enter the names of the hosts that have access to this

current system.

If installing a media server, the NetBackup System Names window contains an
additional line with the media server field containing the virtual server name. You
must enter a master server name for the NetBackup Administration Console that this
media server is configured to.

Note The NetBackup Administration Console is not a clusterable option.
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[l YERITAS NetBackup |

NetBackup System Names -

Itiz highly recommended that you enter the names of all the V E R ] TA S i
zervers you will be ingtalling in the additional servers field.

Master Server Mame: GUAC

Additional Servers: Culf ;I
cul

|

< Back I Mest > I Cancel |

13. Enter additional server names and click Next. You can cut, copy, or delete a server
from the list by selecting a server and using the right mouse button functionality. All
of the nodes of the cluster should be added to the Additional Servers list in this
window.

Note All of the nodes identified in the cluster receive the same server list.

14. Enter the name of the NetBackup Global Device Database Host and click Next. The
Global Device Database Host serves as the repository for global device configuration
information (refer to the NetBackup Media Manager System Administrator’s Guide for
Windows).

By default, the Global Device Database host is the master server name. Under most
circumstances, this can be left as the default. However, you may need to enter a
different host name in the following situations:

¢ If the system shares drives with the Shared Storage Option (SSO), all NetBackup
servers must use the same host for storing device information.

¢ If the system has multiple master servers, enter the name of the server that will
store the global device configuration information. Conflicting host information
may result in an error.
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f] YERITAS NetBackup . |

MNetBackup Global Device Database Host -
Enter the name of the hast that will store global device V E R ] TA S )
information and your preferred authorization group.

For most installations, the global device database host name can remain the same as
the Master Server Mame.

Global Device Database Host Name: IDUAC

< Back I Mest > I Cancel |

15. In the Install NetBackup to Clustered Nodes window, select the cluster nodes from the
Available Systems list and add them to the Destination Systems list. Make sure you
select your local machine when you are selecting systems to install.

Each time you choose a different node in the cluster group to install, NetBackup
performs the following system and license checks:

¢ Verifies the system for a server install matches the type that you selected. The
installation type on that system is compared to the installation type that you are
requesting. If you are requesting an invalid combination, you will be notified of
this and the selection of that system is disallowed.

¢ Verifies that you have proper administration credentials on the node that you
chose. If you do not have administration credentials, the Enter Network Password
window appears and prompts you to enter the administrator’s user name and
password. Click OK, and continue selecting destination systems.

Note This process repeats for each node that you select. In addition, you can elect to
remember the user name and password and only be prompted when the user
name or password is not valid on a particular system.
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[ YERITAS NetBackup x| [z YERITAS NetBackup x|
Install NetBackup to remote systems - Install NetBackup to remote systems -
Select MetBackup destination cluster nodes. V E R ] TA S i Select MetB ackup destination cluster nades. V E R ] TA S )
Lvailable Systems Destination Systems Bvailable Systems Destination Systems

[k QUAC |, QUAC ik GUAC

= cuR
TN

j
ﬂ

- [

< Back I IEst > I Cancel | < Back | Nest » | Cancel |

The following is a list of facts associated with the push-install process in a clustered
environment:

¢ There is no limit to the number of nodes that you can install NetBackup on. The
only limit to the number of nodes in a cluster is that set by the clustering service
and not NetBackup.

¢ NetBackup add-on products such as Global Data Manager (GDM) and
NetBackup Archive and Restore (NBAR) cannot push their installs. These add-on
products must be installed on each individual node in the cluster group. For
instructions on how to install these products, refer to NetBackup documentation
for each product.

¢ Only the license key that was entered at the beginning of this procedure is pushed
to the other nodes in this cluster. If the license key includes add-on products such
as GDM and NBAR, and the nodes you are pushing NetBackup to already have
GDM and NBAR installed, then this key will enable you to use these products.

16. Click Next when you have finished selecting cluster nodes. The installation process
begins pushing the install to all of the selected nodes. The following NetBackup
Installation window appears, providing a status of which nodes are being installed as
well as a completion status.
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rc} YERITAS NetBackup

MetBackup Installation

MetBackup iz being installed on zelected systems.

= MetB ackup has been inzstalled on the selected systems.

VERITAS"

Click. Firih.
Server | Status | 2 Complete
[ERGTE Successiul NetBackup install 100%
Q WWEUL Successful MetBackup install 100%

4]

|

< Back I Finish I Cancel |

17. On the Ready to Install the Program screen, click Install. The cluster install pushes

NetBackup to all selected nodes.

MSI494 .
Click Ok to perform final cluster configuration.

Click cancel to abart the install,

1f wou cancel, you will have to uninstall MetBackup From all of the nodes

of this cluster in order ko reinstall it a5 a cluster,

(04 I Cancel

|

Note You may need to reboot each of the cluster nodes after the installation is complete.

Note For MSCS clusters: Under normal circumstances, cluster configuration is one of the
final steps in installing NetBackup in a cluster. If this step is not done or does not
complete successfully, you can use the bpclusterutil command from the active
node to perform this step. The bpclusterconfig -c command runs the cluster
configuration step performed by installation. Using the -a option with the
appropriate option name configures the NetBackup option in a cluster. This
command can be run multiple times. See the NetBackup High Availability System
Administrator’s Guide for more information
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A summary screen appears that shows you the progress of the installation and each of
the systems. You can right-click on a system listed in the screen to see a status of the
install, for example, it can show if an install failed on a particular system. You would
then be able to obtain more information about the failure by viewing the remote
install log. The remote install log is named nbpinst.log and is located in the
Windows installation directory.

18. Click Next. A screen appears that enables you to do two things before completing the
install:

a. You can select a check box to display the NetBackup Administration Console.

b. You can select a button to enter more license keys on the system you are currently
installing on.

Note If you enter a license key at this time, the key will not be pushed to the other
nodes in the cluster group. You must go to each node in the group and add the
key or keys that you want to add.

{5 NetBackup Setup x|

Completing the NetBackup Setup wizard @

The MNetBackup Setup wizard has successfully installed MetBackup, Click Finish to exit the
Setup wizard,

¥ Launch MetBackup Administration Console nov.

Click Add Keys ko add additional MetBackup license keys,

‘fou must reboot your computer before YERITAS Snapshot Provider will be enabled.

In order for IDR and ¥SP ko be activated for backups, vou must enter an appropriate license
key on your MetBackup Master Server,

‘four administrator may have to change permissions on C:\Program FilesiYERITAS), for
backups ko be successful,

InistallShield

= Back Einish Cancel

19. Click Finish.

20. After the push-install completes:

¢ If you have an MSCS cluster, the NetBackup resources that you took offline in the
beginning of this procedure will come back online automatically.

¢ If you have a VCS cluster, you are ready to unfreeze the active node.
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v

To verify a successful cluster installation using the Cluster Administrator console

1. During a cluster installation you can open the Cluster Administrator console to see
your current structure.

2. In the previous procedure a new cluster named NetBackup Master Server Group was
created. In the following figure you can see Disk Y in the left pane and no other

NetBackup Master Server Group exists.

5 Cluster Administrator - [CORYUS {corvus)] | - |EI|1|
ile  Wiew ‘Window Help =1
& @A X[=| B 2
E|-- CORVU Mame Skake Chner Resource Type Description
=0 Groups Crline Phyysical Disk. Diisk. v

£

i Cluster Group

1) Disk Group 2

1j Disk Group 3

i Disk ¥

| Exchange

| CracleRacyMame
Sybase

D Rsources
=27 Clusker Configuration

D Resource Types
e[ Metworks
(7] Metwork Interfares

g CUL

D Ackive Groups
D Ackive Resources
{7 Metwork Interfaces

El@g CUR

{1 Active Groups
D Ackive Resources

Far Help,

{21 Metwark Interfaces

press F1

I
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3. After you have completed the installation and configuration process, the Cluster
Administrator’s interface updates with the new cluster group in the left pane.

£ Cluster Administrator - [CORYUS {corvus)] | i |EI|1|

File ‘igw ‘Window Help =] x|

Marne | Skate | CIANEr |
[Dpisk v: orline CUR
m MetBackup Master Server Virtual Server IP Address Online CUR
m MNetBackup Master Server Virtual Server Name Online CUR
m MetBackup Master Server Yolume Manager COnline CIUR
@NetBackup Master Server Device Manager Offline CIUR
m MetBackup Master Server Request Manager COnline CUR
m MetBackup Master Server Database Manager Online CUR
[noMe Mover agent online CUR

D Resources

=+ Cluster Configuration
{:l Resource Types
- Metworks

{2 Metwork Intetfaces
CHL

D Active Groups
D Ackive Resources
(7] Metwork Interfares
CUR

D Active Groups b

{0 Adive Resources o
1| | 3| 1| | i

For Help, press F1 i
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Installing NetBackup Silently

Performing a silent installation avoids the need for interactive input in the same manner
as performing a remote installation. Silent installations of NetBackup are not supported if
you want to run the NetBackup services as a user rather than the local system. If you want
to install NetBackup under these circumstances, you must go through the interactive
installation or the standard installation described earlier in this document. The following
procedure describes how to initiate a silent installation.

To install NetBackup server software silently
1. Install the Windows Installer service by double-clicking on the following executable
on the CD (except for Windows 2000 and newer systems):
.\x86\instmsiw.exe
Skip this step for Windows 2000 and newer systems. The Windows Installer service is

already installed on these systems.

2. Copy the contents of the .\Common directory on the CD to a temporary directory on
your hard drive.

Note The files contained on the NetBackup installation CD are read-only. Change the
permissions for these files on the hard drive to allow the update.

3. Inthat temporary directory, modify the appropriate script. (The following list shows
the available items and the corresponding commands.)

& To install a master server, edit: silentmaster.cmd

& Toinstall a media server, edit: silentmedia.cmd

¢ Toinstall a NetBackup Remote Administration Console, edit: silentadmin.cmd
4. If only one server will be accessing the machine, remove the following line from the

script:

SET ADDITIONALSERVERS=medial,media2,media3
5. Save and run the script.

6. Check the log file (NetBackup Install.log in the default TEMP directory) to
verify that the installation was successful.
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Note After the installation completes, a NetBackup installation log file is generated. You
can find this log file at the default temp directory. To determine where your TEMP
directory is located, refer to “To locate the NetBackup installation log file for
Windows 2000, XP, and 2003 systems” on page 22 or “To locate the NetBackup
installation log file for Windows NT systems” on page 23.

Note By default, a silent install will not reboot your system.

VERITAS recommends that when you upgrade or patch a client or server, make
sure no backup processes are currently running. However in rare circumstances a
reboot may be required for the changes to take effect. To detect if a reboot is needed
after you have run the silentemd.cmd., locate the % TEMP%\NetBackup Install.log,
search for the key words “in use”. If files are in use, a reboot is required.

To force a reboot when required during a silent install, modify the script
(silentcmd.cmd) and remove this option, REBOOT="ReallySuppress" WARNING:
This will reboot the system you are installing to without warning.
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Upgrading NetBackup 3

This chapter describes how to upgrade to NetBackup 5.1 from a previous version of
NetBackup, or from NetBackup Server to NetBackup Enterprise Server. It also describes
how this version can handle media servers with different versions of NetBackup running.

Handling Mixed Media Server Revisions

This release of NetBackup supports mixed versions between master and media servers,
enabling you to upgrade NetBackup one server at a time and with minimal impact on the
overall system performance.

This capability, being transparent to the end user, enables servers to pull and push their
version information between master and media servers. The version of NetBackup you
have installed on your server determines if the version information can be pushed. A
media server that is upgraded to NetBackup 5.1 utilizes the vind service to push its
version information to all servers in its master server list after start-up is initiated. In
addition, every 24 hours an automatic update occurs at which time servers with this
revision push their version information out to the servers again.

Servers running a version of NetBackup that is earlier than NetBackup 4.5 FP3
(NetBackup 4.5GA or 4.5MPx) cannot push their version information to other servers. You
must use the vnetd daemon on the master server to query the media servers and
determine relative version information. (This information is then stored in the file
install_directory/NetBackup/Remote_Version).If the query of a particular
server times out, then it is classified as a “pre-4.5” version of NetBackup in which case,
this version of NetBackup continues to support the interoperability of the earlier version
of NetBackup.

The following sections describe how to upgrade NetBackup.

Caution Before you upgrade the NetBackup software on the master server:
— Back up your NetBackup catalogs.
— Verify that the catalog backup was successful.
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Upgrading to this version of NetBackup is as easy as following the normal installation
process. In fact, that is exactly what you do. The installation process detects an earlier
version of NetBackup, if one exists, and determines if it is possible to upgrade to
NetBackup 5.1 from the version detected. Read through the following notes and
requirements before you begin upgrading NetBackup.

The following sections describe how to upgrade to this version of NetBackup. Also
included in this section is a procedure on how to perform upgrades in a clustered
environment.

Notes and Requirements About Upgrading to this Release

¢ If you are concerned that your current installation of NetBackup is corrupt, then you
should uninstall that product first, and then perform a clean install.

¢ You can upgrade to this version of NetBackup only if the NetBackup software that
you currently have installed is NetBackup 4.5GA or greater.

Note VERITAS supports an upgrade from NetBackup 4.5GA, 4.5 FPx, 4.5 MPx, or 5.0
to this version of NetBackup. However, VERITAS does not support an upgrade
directly from NetBackup 3.4 and 3.4.1 to NetBackup 5.0 or NetBackup 5.1. If
you currently have either NetBackup 3.4 and 3.4.1 installed, you must upgrade
to NetBackup 4.5GA, 4.5 FPx, or 4.5 MPx first and then you can upgrade to
NetBackup 5.0 or NetBackup 5.1.

¢ Anupgrade to this version of NetBackup requires a minimum of 500MB of disk space.

¢ VERITAS recommends that you upgrade in the following order:
a. Master server
b. Media servers, if any (NetBackup Enterprise only)
c. NetBackup Remote Administration Console, if any
d. NetBackup clients

e. Any NetBackup Add-on products

¢ Changing a master server into a media server is not an allowable upgrade. This is
considered a downgrade. If an upgrade is not allowed, the install wizard will not
permit it, requiring that you first uninstall the current version of NetBackup and
perform a new install.

52

NetBackup Installation Guide for Windows



¢ Make certain that the NetBackup release level on the server is at least equal to that on
the clients. Older versions of server software can encounter problems with newer
clients.

¢ Add-ons, with the exception of NetBackup Advanced Reporter, must be at the same
level as the NetBackup client or server on which the add-on is installed.

& Enterprise only: You can upgrade to this version on systems that support a clustered
configuration. For instruction on how to upgrade NetBackup in a clustered
environment, see “Upgrading NetBackup in a Clustered Environment” on page 54.

Upgrading NetBackup Server to NetBackup Enterprise Server

Upgrading from NetBackup Server to NetBackup Enterprise Server requires you to enter
the appropriate license key(s) in your current NetBackup Administration Console.

Vv To upgrade NetBackup Server to NetBackup Enterprise Server
1. Locate your NetBackup Enterprise Server license key.
2. Open the NetBackup

Administration Console
window. Click Help >

=% NetBackup License iKeys x|

moha

License Keys. The —Cutrent Licenses
. " Summary of active licensed features @ o
NetBaCkup LICQHSE Key & All registered license keys details % @ ﬂ
window appears. License Ke: [server [ Date [ Feattres [
¥ AJNY-CENZ-JBIS-FPEPC-PFP.. moha 12/6/2001 3:26:46 PM  Intelligent Disaster

v AJNY-CENEZ-JBJF-FEPC-PFP.. moha 12/6/2001 3:26:46 FM  Base MetBackup

3. Click on the New icon. ﬂ

4. Type your license key in the
New license key field and
click Add.

The new license key appears

in the field in the lower part
of the dialog. N

A

Note When you upgrade from a NetBackup server evaluation license key to a permanent
NetBackup Enterprise Server-based product license key on Windows, restart the
NetBackup services. Restarting the services ensures that the proper licensing
information is displayed after selecting Help > About NetBackup Administration
Console.

Note If you make and save any license key updates (including adding and deleting
license keys), you must restart the NetBackup Administration Console.

Chapter 3, Upgrading NetBackup 53 Y9



5. The system may require a reboot to complete the upgrade. When prompted to reboot,
click OK.

Upgrading NetBackup in a Clustered Environment

This procedure explains how to upgrade NetBackup master server software or media
server software in a clustered environment to multiple Windows systems from a single
Windows system. Review the installation requirements for NetBackup on page 14 before
starting this procedure.

Follow these instructions to upgrade the NetBackup software on selected Windows NT,
Windows 2000, or Windows 2003 servers on the active node in your clustered
environment. You may stop the installation process at any time by clicking Cancel.

Note The NetBackup server setup program cannot clean up an aborted install. Therefore,
if you stop Setup while it is copying files to a client, the files that have been
successfully installed are not uninstalled.

Vv To prepare to upgrade NetBackup in a clustered environment

1. When upgrading NetBackup in a clustered environment you must first do the
following:

¢ When upgrading NetBackup in a MSCS cluster you must take all of the
NetBackup group resources offline except for the disk. Refer to the Microsoft
Cluster Administration documentation to determine how to take the NetBackup
group resources offline using the Cluster Administrator interface.

¢  When upgrading NetBackup in a VCS cluster, you must freeze the active node so
that migrations will not occur while the inactive nodes are upgraded. If you have
a VCS cluster configured, then you can freeze the active node using the Cluster
Manager interface, or the command line.

2. After you take the cluster offline (for MSCS clusters) or freeze the active node (VCS
clusters), you are ready to begin the upgrade process. Perform the procedure as
described in, “To upgrade NetBackup in a clustered environment.” (Upgrading
NetBackup in a VCS cluster installs each node as non-clustered. When the installation
is complete, run the VCS configuration wizard for NetBackup.)

Vv To upgrade NetBackup in a clustered environment

1. Log in as Administrator on the active node.

2. Insert the NetBackup installation CD in the drive.
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¢ On Windows systems with AutoPlay enabled for CD-ROM drives, the VERITAS
NetBackup installation browser starts automatically.

¢ On Windows systems that have AutoPlay disabled, run Launch.exe in the
top-level directory on the CD.
3. The NetBackup browser displays the following information and options:

¢ Links on the left side of the browser that display information relating to
NetBackup, Database Agents, and Additional Products.

¢ Browse the installation CD
¢ The NetBackup link selected (by default) and these available options:
¢ Begin NetBackup installation
¢ View available documentation
¢ Link to VERITAS Technical Support
¢ Link to VERITAS e-Learning

4. Click NetBackup Installation. The browser refreshes and displays pre-installation
information.

5. Click Start NetBackup Server Installation.

6. To proceed with the installation, you must check the I accept the terms of the license
agreement option, then click Next.

7. This step applies only to MSCS clusters. Select Perform a clustered install of
NetBackup, then click Next.

Note The installation process references the registry settings of your system to determine
if your system is configured for a Windows MSCS clustered environment. If your
system is configured for a MSCS clustered environment, the Perform a clustered
install of NetBackup option is available for selection.
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[ YERITAS NetBackup . |
MetBackup Installation Type -
Select where you want to install MetBackup V E R ] TA S )

= Install ta this computer only.

" Select from available computers on the network

' Perform a clustered install of MetB ackup.

If you choosge the "Select from available computers on the network" option, Setup will scan your
network for available systems.

< Back I Mest > I Cancel |

Note The first two options may be disabled depending on your system configuration.

8. Enter the base product license key that you received when you purchased your
product. During this installation process, the following events occur to ensure you
have proper credentials to perform remote installations:

¢ When performing an upgrade a new license key is not required. Your current
license key will be used.

¢ When you choose to install on a clustered system:

¢ NetBackup determines if you have proper administration credentials on all
nodes in the cluster. If you do not have the proper credentials, the system is
not added to the list.

¢ If you have the proper credentials, NetBackup performs a second check and
determines if a license key is needed. If a license is needed and one was not
entered, the system cannot be added to the list. You must enter a valid license
key to install to that node.

¢ If you enter an invalid license key, the NetBackup License Key and Server Type
screen remains visible until a valid key is entered.

The license key that you enter determines which of the installation options are
available for you to install.
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B\ VERITAS NetBackup
MetBackup License Key and Server Type

™
Enter your MetBackup license key and select the type of V E R ] T A S
MetBackup installation to perform.

License Key CEME-DRPH-2PPR-3w0P-6ZPC-PRCP-PIPP-340Z-H

£

b

L

Licenze Type: MetBackup Enterprise Server
E=piration Date: Thursday, July 31, 2003

MetBackup Master Server

Install a Master Server. At least one Master Server iz required for MetBackup to
properly function.

MetBackup Media Server
Install a Media Server. & MetBackup Master Server iz required for the Media Server to
properly function.

HetBackup Bemote Administration Console

Inztall & Femate &dministration Console. The Bemate Administration Consale allows
you ko remotely administer any number of HetBackup Servers fram one lacation,

< Back | Tewt > | Cancel |

9. Select the type of installation that you want to perform.

From the Setup Type window, you can elect to perform a typical or a custom
installation. Refer to “Customizing a NetBackup Installation” on page 25 to see the
differences in the installation processes.

10. Select Typical and click Next.

11. In the Cluster Settings window, enter the appropriate data in each of the fields. These
fields are listed below along with a brief description of each field.

Note During an upgrade, these parameters must match the existing parameters to
successfully complete the upgrade.

4

NetBackup Cluster Group Name: A name used to identify a NetBackup service
group or resource group. A resource group is comprised of resources that are
related and interdependent to each other.

Virtual Host Name: The name of the cluster as known by the NetBackup
environment. This is the name that will be entered in the client server list. It is also
the name that the server uses when communicating to the client nodes.

Virtual IP Address: This is the IP address of the cluster. The address to which the
virtual server name should resolve.

Subnet Mask: A mask used to identify a subnetwork so that IP addresses can be
shared on a local area network. This number correlates directly to the virtual IP
address of the cluster.
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¢ Path to Shared Data: This path indicates a directory on one of the shared disks in
the cluster where NetBackup stores configuration information.

¢ Public Network - When installing NetBackup on a clustered system, choose one
of the public networks assigned to the node of the cluster.

Caution You must not select the private network assigned to this cluster.

Note The cluster configuration settings that you enter in the Cluster Settings dialog
must be identical to the settings on the existing NetBackup configuration for the
cluster group.

x
Cluster Settings -
Enter the parameters to be used by MetBackup in thiz V E R ] T A Sm
clustered environment.
MetBackup Cluster Group Mame INetBaCkup Master Server Group
Yirtual Host Name IQUAE
Yirtual P Address I o . 80 13 3
Subnet Mask | 25 .25 . 255 . 0
Path to Shared Data |Y:\F‘rogram Files\veritas j
Public Metwark I j
< Back I Mest > I Cancel

12. Click Next. The NetBackup System Names window appears.

From this window you can enter the names of the hosts that have access to this
current system.

If installing a media server, the NetBackup System Names window contains an
additional line with the media server field containing the virtual server name. You
must enter a master server name for the NetBackup Administration Console that this
media server is configured to.

Note The NetBackup Administration Console is not a clusterable option.
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[} YERITAS NetBackup x|

NetBackup System Names -

Itiz highly recommended that you enter the names of all the V E R ] TA S i
zervers you will be ingtalling in the additional servers field.

Master Server Mame: GUAC

Additional Servers: Culf ;I
cul

|

< Back I Mest > I Cancel |

13. Enter additional server names and click Next. You can cut, copy, or delete a server
from the list by selecting a server and using the right mouse button functionality. All
of the nodes of the cluster should be added to the Additional Servers list in this
window.

Note All of the nodes identified in the cluster receive the same server list.

14. In the Install NetBackup to Clustered Nodes window, select the cluster nodes from the
Available Systems list and add them to the Destination Systems list. Make sure you
select your local machine when you are selecting systems to install.

Each time you choose a different node in the cluster group to install, NetBackup
performs the following system and license checks:

¢ Verifies the system for a server install matches the type that you selected. The
installation type on that system is compared to the installation type that you are
requesting. If you are requesting an invalid combination, you will be notified of
this and the selection of that system is disallowed.

¢ Verifies that you have proper administration credentials on the node that you
chose. If you do not have administration credentials, the Enter Network Password
window appears and prompts you to enter the administrator’s user name and
password. Click OK, and continue selecting destination systems.

Note This process repeats for each node that you select. In addition, you can elect to
remember the user name and password and only be prompted when the user
name or password is not valid on a particular system.

Chapter 3, Upgrading NetBackup 59 —



(A YERITAS NetBackup X il VERITAS NetBackup x|

Install NetBackup to remote systems - Install NetBackup to remote systems -
Select MetBackup destination cluster nodes. V E R ] TA S i Select MetB ackup destination cluster nades. V E R ] TA S )

Lvailable Systems

Destination Systems Bvailable Systems Destination Systems

[k QUAC |, QUAC ik GUAC

= cuR
TN

[

j
ﬂ

< Back I IEst > I Cancel | < Back | Nest » | Cancel |

15.

The following is a list of facts associated with the push-install process in a clustered
environment:

*

There is no limit to the number of nodes that you can install NetBackup on. The
only limit to the number of nodes in a cluster is that set by the clustering service
and not NetBackup.

NetBackup add-on products such as Global Data Manager (GDM) and
NetBackup Archive and Restore (NBAR) cannot push their installs. These add-on
products must be installed on each individual node in the cluster group. For
instructions on how to install these products, refer to NetBackup documentation
for each product.

Only the license key that was entered at the beginning of this procedure is pushed
to the other nodes in this cluster. If the license key includes add-on products such
as GDM and NBAR, and the nodes you are pushing NetBackup to already have
GDM and NBAR installed, then this key will enable you to use these products.

Click Next when you have finished selecting cluster nodes. The installation process
begins pushing the install to all of the selected nodes. The following NetBackup
Installation window appears and provides a status of which node is being installed
along with the completion status. You can right-click on a system listed in the screen
to see a status of the install, for example, it can show if an install failed on a particular
system. You would then be able to obtain more information about the failure by
viewing the remote install log. The remote install log is named nbpinst.log and is
located in the Windows installation directory.
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rc} YERITAS NetBackup

NetBackup Installation -

MetBackup iz being installed on zelected systems. V E R ] T A Sm

= MetB ackup has been inzstalled on the selected systems.

Click Finish.

Server | Status | 2 Complete
[ERGTE Successiul NetBackup install 100%

Q WWEUL Successful MetBackup install 100%

4] 1]

< Back I Finish I Cancel |

16. On the Ready to Install the Program screen, click Install. The cluster install pushes
NetBackup to all selected nodes.

MSI494 _ x|
Click Ok to perform final cluster configuration.
Click cancel to abart the install,

1f wou cancel, you will have to uninstall MetBackup From all of the nodes
of this cluster in order ko reinstall it a5 a cluster,

(04 I Cancel

Note Reboot any of the inactive cluster nodes that the summary screen displayed as a
required reboot. After you have rebooted all inactive nodes that required rebooting,
proceed to reboot the active node (the node where you ran the install) if the
summary screen says it requires a reboot. It is imperative that you reboot the
inactive nodes before you reboot the active node.

Note For MSCS clusters: Under normal circumstances, cluster configuration is one of the
final steps in installing NetBackup in a cluster. If this step is not done or does not
complete successfully, you can use the bpclusterutil command from the active
node to perform this step. The bpclusterconfig -c command runs the cluster
configuration step performed by installation. Using the -a option with the
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appropriate option name configures the NetBackup option in a cluster. This
command can be run multiple times. See the NetBackup High Availability System
Administrator's Guide for more information

17. Click Next. A screen appears that enables you to do two things before completing the
install:

a. You can select a check box to display the NetBackup Administration Console.

b. You can select a button to enter more license keys on the system you are currently
installing on.

Note If you enter a license key at this time, the key will not be pushed to the other
nodes in the cluster group. You must go to each node in the group and add the
key or keys that you want to add.

{5 NetBackup Setup x|

Completing the NetBackup Setup wizard @

The MNetBackup Setup wizard has successfully installed MetBackup, Click Finish to exit the
Setup wizard,

¥ Launch MetBackup Administration Console nov.

Click Add Keys ko add additional MetBackup license keys,

‘fou must reboot your computer before YERITAS Snapshot Provider will be enabled.

In order for IDR and ¥SP ko be activated for backups, vou must enter an appropriate license
key on your MetBackup Master Server,

‘four administrator may have to change permissions on C:\Program FilesiYERITAS), for
backups ko be successful,

InistallShield

= Back Einish Cancel

18. Click Finish.

19. After the push-install completes:

¢ If you have an MSCS cluster, the NetBackup resources that you took offline in the
beginning of this procedure will come back online automatically.

¢ If you have a VCS cluster, you are ready to unfreeze the active node. You must
then run the VCS configuration wizard for NetBackup and update the NetBackup

group.
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¥ To verify a successful cluster installation using the Cluster Administrator Console

1. During a cluster installation you can open the Cluster Administrator console to see
your current structure.

2. After you have completed the installation and configuration process, the Cluster
Administrator interface updates the cluster group in the left pane.

[ =[5
=18l x|
i | State | Qwner |
=0 Groups [ pisk v: orline CUR
4 m MetBackup Master Server Virtual Server IP Address Online CUR
m MNetBackup Master Server Virtual Server Name Online CUR
m MetBackup Master Server Yolume Manager COnline CIUR
@NetBackup Master Server Device Manager Offline CIUR
m MetBackup Master Server Request Manager COnline CUR
OracleRacMame m MetBackup Master Server Database Manager Online CUR
§ syhase [noMe Mover agent online CUR
D Resources
=+ Cluster Configuration
{:l Resource Types
-0 Metwarks
(7] Metwork Interfares
E-@g UL
D Active Groups
D Ackive Resources
(7] Metwork Interfares
Elag CUR
D Active Groups b
{0 Adive Resources o
d| _ L _’lJ 2l | 2
Faor Help, press F1 [
—
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Installing Alternative Administration Interfaces 4

This chapter provides instructions on installing a NetBackup user interface on a different
computer. (This is necessary if your server has no graphics display capabilities.)The
following table identifies the interface you can install for a given system:

System Install this user interface

Windows NetBackup Remote Administration Console
UNIX UNIX (NetBackup-Java capable) host
Windows NetBackup-Java Windows Display Console

The subsections in this chapter provide the installation procedures for each
system/interface combination shown in the table.

NetBackup Remote Administration Console for Windows

You can skip this section if you do not want to remotely administer a NetBackup server
from a Windows NetBackup client.

The NetBackup Remote Administration Console for Windows servers is a version of
NetBackup for Windows that can be used to remotely administer one or more UNIX or
Windows NetBackup servers. It provides all of the standard NetBackup Server for
Windows interfaces and can be used to create backup policies, manage volumes, view
status, monitor tape drives, etc., on a remote NetBackup server. It cannot be used alone as
a NetBackup master or media server—only for the remote administration of other
NetBackup 4.5 (and greater) UNIX or Windows servers.

Note The Windows NetBackup servers that support the NetBackup Remote
Administration Console are Windows NT, Windows 2000, Windows XP, and
Windows 2003. For information about the supported platforms for the
NetBackup 5.1 release, refer to the Supported Platforms and Peripherals chapter in
NetBackup Release Notes for UNIX and Windows.
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Although the NetBackup Remote Administration Console cannot be used alone as a
master or media server, in order for it to remotely administer a NetBackup server, it must
be added to the server list on that server in the same way that other NetBackup servers are
added to the server list to give them access to that server.

The NetBackup manuals and online help do not, in most cases, specifically refer to the
NetBackup Remote Administration Console since, for all practical purposes, using the
NetBackup Server for Windows interfaces on the NetBackup Remote Administration
Console is identical to using them locally on the server that is being administered. Of
course, the master server or device host shown in the interface will be the server name
that is being administered instead of the local server name.

Vv To install the remote server
1. Go to the computer on which you want to install the NetBackup Remote
Administration Console and insert the installation CD.
¢ On Windows systems with AutoPlay enabled for CD-ROM drives, the VERITAS
NetBackup installation browser starts automatically.
¢ On Windows systems that have AutoPlay disabled, run Launch.exe in the
top-level directory on the CD.

2. In the NetBackup wizard, click NetBackup Installation.

3. Click Start NetBackup Server Installation.

4. Click OK.

5. Click Next.

6. Click I Accept.

7. Click Next.

8. Select the Installation Type.

9. Click Next.

10. Select NetBackup Remote Administration Console.

11. Follow the prompts to complete the installation.

Note On the NetBackup System Names screen, the name of the NetBackup Remote
Administration Console should be in the first entry field. You must enter the name
of the remote NetBackup computer in the master server field.
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When the software is installed, a set of NetBackup documents are also installed in the
following directory:

<install path>\Help

The variable, <install_path>,is a default location that is typically defined by your
system. For some systems this path is, C: \Program Files\VERITAS.

By default, the NetBackup Remote Administration Console will automatically begin
as soon as you click Finish in the installation program. (If you did not choose that
default, go to the Windows Start menu on the NetBackup Remote Administration
Console computer and select Start > Programs > VERITAS NetBackup > NetBackup
Administration Console.)

v To add the NetBackup Remote Administration Console host to the server list of the
remote Enterprise Server

Note On a UNIX system, there are two methods for adding the host to the server list: the
NetBackup-Java Administration Console (if your system is NetBackup-Java
Console compatible) or the bp . conf file. Step 1 describes this process using the
NetBackup-Java Administration Console and Step 2 describes how to edit the
bp . conf file.

1. Use the NetBackup-Java Administration Console to specify and add the remote UNIX
Enterprise server to the server list.

a. In the left pane of the NetBackup-Java Administration Console, expand Host
Properties > Master Servers. The master servers appear in the Details pane.

b. Right-click on the name of the master server in the Details pane.

c. Select Properties. The Master Server Properties window appears.

d. In the Master Server Properties window, select Servers.

e. In the Servers window, next to the Additional Servers list, click the Add.

f. Type the name of the host that is to run the NetBackup Remote Administration
Console.

g. Click OK. The name of the host appears in the Additional Servers list.
h. Click OK. (If you perform this step you can proceed to step 3.)

2. Edit the bp. conf file to add the remote UNIX Enterprise server to the server list.
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a. Go to the remote NetBackup UNIX server.
In the /usr/openv/netbackup/bp.conf file, at the end of the SERVER =
lines, add the following line:

SERVER = name-of-Administration-Console-machine
Where name-of-Administration-Console-machine is the name of the machine where

the NetBackup Remote Administration Console will be installed.

3. If you have an existing NetBackup Remote Administration Console installed and you
want to add a remote master server, perform the following steps.

a. Go to the remote NetBackup Windows server and start the NetBackup
Administration Console.

Note If this is a clean installation, you can add the master servers that you want to
administer as additional servers during the install.

b. In the left pane of the NetBackup-Java Administration Console, expand Host
Properties > Master Servers. The master servers appear in the Details pane.

c. Right-click on the name of the master server in the Details pane.

d. Select Properties. The Master Server Properties window appears.

€. In the Master Server Properties window, select Servers.

f. Inthe Global Operations box, in the field labeled Add to all lists, type the name
of the host that is to run the NetBackup Remote Administration Console. Then

click the “+” button. (The name of the host appears in the Additional Servers list.)

g. Click OK.
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NetBackup Remote Administration Console for UNIX

You can skip this section if you do not want to remotely administer a NetBackup server
from a UNIX NetBackup host.

The NetBackup Remote Administration Console for UNIX can be used to remotely
administer one or more UNIX or Windows NetBackup servers. It provides all of the
standard NetBackup Server for Windows interfaces and can be used to create backup
policies, manage volumes, view status, monitor tape drives, and other activities, on a
remote NetBackup server.

On UNIX NetBackup-Java capable servers and clients, the administration console is
installed when you install NetBackup on the host. For remote administration of any
Windows or UNIX NetBackup servers, simply specify the server name in the Login dialog
of the administration console. Refer to the NetBackup Installation Guide for UNIX if you are
installing on a new NetBackup-Java capable UNIX host. In addition, you can refer to the
NetBackup Administrator’s Guide for UNIX and Windows, Volume 1.
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Installing NetBackup-Java Windows Display Console

The NetBackup-Java Windows Display Console enables you to run the NetBackup Java
(UNIX) interfaces on any supported Windows server platforms. This interface provides
the same capabilities as the NetBackup Administration Console for Windows or UNIX.

Skip this section if you do not want to remotely administer your UNIX NetBackup servers
using the NetBackup-Java Windows Display Console on a Windows server.

Note You can install the NetBackup-Java Windows Display Console from the NetBackup
installation CD.

Requirements

For the computer on which you want to run the NetBackup-Java Windows Display

Console, VERITAS recommends 512 MB of physical memory.

To install the NetBackup Java Windows Display Console

1. On the system where you are performing the installation, insert the CD that contains
the NetBackup server software.

¢ On Windows systems with AutoPlay enabled for CD-ROM drives, the NetBackup
install program starts automatically.

¢ On Windows systems that have AutoPlay disabled, run Launch.exe in the
top-level directory on the CD.

2. On the NetBackup Install browser, click the appropriate Install Java Windows Display
Console link. You can elect to install a 32-bit or a 64-bit Java Windows Display
Console.

3. Continue the installation by following the prompts to install the NetBackup-Java
Windows Display Console.

4. When the software is installed, see the following document for information on using
the display console (this document is installed with the software):
install path\Java\Readme.txt

Where, by default, install path isC:\Program Files\VERITAS.
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Uninstalling and Reinstalling NetBackup 5

This chapter provides instructions for uninstalling and reinstalling NetBackup software.

Uninstalling NetBackup Server Software

Caution The uninstall process deletes the VERITAS /NetBackup directory from the
server. In a typical installation, NetBackup add-ons products and catalogs are
installed and contained under this same directory and would also be deleted. If
you intend to reinstall NetBackup, save the configuration, catalog, and log file
information before proceeding. (See “To uninstall NetBackup server software
and save catalog data for Windows 2000 (and greater) users” on page 71.)

v To uninstall NetBackup server software
1. Select Start > Settings >Control Panel. The Control Panel window appears.

2. From the Control Panel window, double click the Add/Remove Programs icon. The
Add/Remove Programs window appears.

3. Select VERITAS NetBackup from the Currently Installed Programs list.

4. C(Click Remove.

Note On Windows NT systems, this button is named Change/Remove. This document
refers to terminology that is used on the latest product releases.

v To uninstall NetBackup server software and save catalog data for Windows 2000
(and greater) users

Note For Windows 2000 (and greater) users, clicking Remove during a product uninstall,
by default, removes all NetBackup configuration and catalog information. The
following procedure explains the necessary steps to retain this information for
future reinstalls.




Uninstalling NetBackup Server Software

Select Start > Settings >Control Panel. The Control Panel window appears.

From the Control Panel window, double click Add/Remove Programs. The
Add/Remove Programs window appears.

Select VERITAS NetBackup from the Currently Installed Programs list.
Click Change. This action enables you to modify, repair, or remove NetBackup.
Select Remove on the Program Maintenance Dialog.

Clear the Remove all NetBackup Configuration, Catalog, and Log files check box to
disable this function. (This check box contains a check mark by default.)

Click Remove.

If NetBackup Access Control is enabled, NetBackup creates several new files on
clients and servers. For more information on NetBackup Access Control, please see
the NetBackup System Administrator’s Guide Volume II. For more information on the
VERITAS Security Services, including how to properly uninstall, please see the
VERITAS Security Subsystem Administrators Guide.

These files can be divided into two separate categories: individual user files, and
NetBackup application temporary files. NetBackup application temporary files were
removed with NetBackup in a previous step. Users’ cache files exist in their home
directories, for example:

<user_dir>\Local Settings\Applications Data\VERITAS\NetBackup.

Note Files are generated in the \NetBackup directory only by the single sign-on
operation of the NetBackup Administration Console on the host upon which
the console is run. NetBackup Administration Console cleans these files when
an exit function is performed. (It is common to have no temporary files in this
directory.) If a system crash were to occur, these files may be left behind. With
the console shutdown, you can delete these files safely with no data loss.

NetBackup also creates cached certificates for client and server NetBackup
applications. These files reside within the \NetBackup directory. These files typically
have a name that is consistent with a DNS entry for a network interface that is
readable by a human, for example, machine . company . com.

Example directory entries for Windows;

<user_dir>\Local Settings\Applications Data\VERITAS\
NetBackup\machine.company.com

user_dir>\Local Settings\Applications Data\VERITAS\
NetBackup\dhcp
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These files are created with the command bpnbat -LoginMachine. If considering a
reinstallation of NetBackup at a later date on the machine in question, you should
preserver the certificates in the \NetBackup directory or be prepared to provide the
machine identity password as originally set on the Root+AB broker. As an alternative,
one may reset the password on the Root+AB broker at reinstall time. For more
information on Root+AB brokers please see the VERITAS Security Subsystem
Administrators Guide.

Uninstalling NetBackup from a Clustered Environment

Follow the instructions in your cluster documentation for removing a group. Then
uninstall NetBackup from each node on which it was installed in the cluster, following the
previous instructions for a basic NetBackup uninstall. There is no shortcut for uninstalling
NetBackup from multiple nodes at the same time.

Reinstalling NetBackup Server Software

This procedure describes how to install NetBackup after you have uninstalled the
product, but saved your configuration, catalog, and log files.

v To reinstall NetBackup server software with saved configuration and catalog
information

1. When reinstalling a NetBackup product, you should have your license key(s)
available throughout the installation process.

Caution You must reinstall this product in the exact location as the previous installation
to ensure that your saved configuration, catalog, and log files will function
properly with the new product.

2. Login as Administrator on the server where you are installing NetBackup.

3. Insert the NetBackup installation CD in the drive.

¢ On Windows systems with AutoPlay enabled for CD-ROM drives, the VERITAS
NetBackup installation browser starts automatically.

¢ On Windows systems that have AutoPlay disabled, run Launch.exe in the
top-level directory on the CD.

The NetBackup browser window appears.
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4,

10.

Select NetBackup Installation.The browser refreshes and displays pre-installation
information.

Click the appropriate installation link (client or server) that you want to start. The
NetBackup Setup wizard begins.

Click Next to continue the reinstall /upgrade.
Check the I accept the terms of the license agreement option, then click Next.

Select where you want to install NetBackup (locally, or to another computer) and click
Next. The NetBackup License Key and Server Type window appears.

Enter the base product license key that you received when you purchased your
product. The license key determines which installations are available for you to

install.

Select the type of installation that you want to perform.

Note Installing the NetBackup Remote Administration Console does not require a license

key.

11.

12.

13.

Click Next. The Setup Type window appears. You can elect to perform a typical or a
custom installation. Refer to “Customizing a NetBackup Installation” to see the
differences in the installation processes.

Select Typical and then click Next. The NetBackup System Names window appears.

In the NetBackup System Names window, enter the names of other systems that are
allowed access to this server.

Note If installing a NetBackup media server or the NetBackup Remote Administration

Console, the NetBackup System Names window will have an additional line with
the local media server filled in. You must enter the name of a master server to which
the media server is configured.

14.

Enter the server names and click Next. The NetBackup Global Device Database Host
window appears.
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15. Enter the name of the BB\ VERITAS NetBackup =

NetBaCkup GIObal Device MNetBackup Global Device Database Host -
Database HOSt, which serves Enter the name of the hast that will store global device V E RI TA Sm
as the repOSitOI'y for global information and your preferred authorization group.

deVICQ Conflguratlon For mogt inzstallations, the global device databaze host name can remain the same as
information. FOI' more the Master Server Mame.

1nf0rmat10n about the GlObal Global Device Databaze Host Mame: IithtED

Device Database Host, see

the Media Manager System

Administrations Guide for

Windows.

By default, the Global Device
Database Host is the master
server currently being
installed. Under most
circumstances, this can be left
as the default. However, you may need to enter a different host name in the following
situations:

< Back I Mest » I Cancel |

¢ If the system shares drives with the Shared Storage Option (SSO), all NetBackup
servers must use the same host for storing device information.

¢ If the system has multiple master servers, enter the name of the server that will
store the global device configuration information. Conflicting host information
may result in an error.

Note If you want to make changes to the installation settings, click Back until you reach
the page where you can make the change, or click Cancel and exit the wizard.

16. Click Install. The installation process begins. This process could take several minutes.

Note After the installation completes, a NetBackup installation log file is generated and
placed in your default TEMP directory. The following procedures explain how to
verify the location of your TEMP environment variable.

Vv To locate the NetBackup Installation log file for Windows 2000 systems

a. Select Start > Programs > Accessories > Command Prompt. A command prompt
window appears.

b. Enter echo %TEMP% and press the Return key on your keyboard. The location of
your TEMP directory will display.
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¥ To locate the NetBackup Installation log file for Windows NT systems

a. Select Start > Settings > Control Panel. The Control Panel window appears.

Note Make sure you can view all hidden files and folders. To set this option, select Tools
> Folder Options... in the Control Panel window. Then click the View tab; set the
Show hidden files and folders option, and click OK.

b. Double-click the System icon. The System Properties window appears.

c. Click the Environment tab. The Environment Variables including the TEMP
variable appears along with the corresponding paths for each variable.
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By default, the NetBackup Administration Console launches automatically following the
installation. From this console you are able to configure NetBackup by using the Getting
Started wizard. For detailed information about the NetBackup Administration Console,
refer to the NetBackup Administrator’s Guide, Volumes I and 1I. For help while running a
wizard, click Help in the wizard screen.

Recommendations for Configuring NetBackup

The following list outlines some basic tips to follow before you begin the process of
configuring NetBackup on your system.

¢ Before configuring NetBackup, make sure you have physically attached the storage
devices to the server and performed all configuration steps specified by the device
and operating system vendor (including installation of any required device drivers
and software patches).

¢ Once the server software and storage devices have been installed, select the Getting
Started wizard in the right pane of the NetBackup Administration Console. Then
follow the steps of each wizard until you have finished configuring your product.

Note If you elected to not have the console start after the installation by default, you
can open the console by selecting, Start Programs > VERITAS NetBackup >
NetBackup Administration Console.

¢ If you are configuring NetBackup for the first time, we recommend that you click
on the Getting Started icon and use this set of wizards to guide you through the
process.

¢ If you have already configured NetBackup and you want to change a particular
area, you can click on the any of the wizards.

¢ Configuring master and media servers

This bulleted item applies only to NetBackup Enterprise Server.
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The process of configuring a master or media server is very similar, and the versatility
of NetBackup enables you to install either server first. However, VERITAS
recommends that you install and configure the master server before you install and
configure a media server. You can then configure the media server information (such
as storage devices and volumes) on the master to ensure the master server will
properly administer the media server. The following list offers some tips when
configuring a media server.

¢ The NetBackup Administration Console appears after you install the media
server. The name of the master server will appear as the host server name in the
left window pane of the NetBackup Administration Console if the master server
was installed before the media server.

¢ The name of the media server appears as the host server name in the left window
pane of the NetBackup Administration Console if any of the following conditions
exist:

¢ The master server has not been installed.
¢ The media server does not have permissions set on the master server.

¢ A network problem exists blocking the media server from communicating
with the master server.

Caution If any of these situations exist, you will still be presented with the opportunity
to run three of the configuration wizards (Storage Device, Volumes, and
Configure a Shared Drive). Do not run these wizards. If you run these wizards,
the information that you enter will not be recognized by the master server.
VERITAS recommends that you correct the problem (such as installing the
master server, correcting the permission settings, or solving the network
problem) and run the configuration wizards from the master server.

Configuring NetBackup

To begin configuring your product, click on the Getting Started icon in the main window
of the NetBackup Administration Console. The Getting Started - Welcome to NetBackup
window appears. This will lead you through a series of wizards designed to make it easy
for you to configure the following:

¢ Configure Storage Devices

¢ Configure Volumes

¢ Configure the Catalog Backup
¢ Create a Backup Policy

- 78 NetBackup Installation Guide for Windows



Configuring NetBackup

The following subsections contain helpful tips as you step through the wizard. For
detailed information about the NetBackup Administration Console, refer to the NetBackup
Administrator’s Guide, Volumes I and 11. For help while running a wizard, click Help in the
wizard screen.

Configuring Storage Devices for NetBackup

Before you can run any backups, you must define your storage devices for NetBackup.
You should take the following into consideration while you complete the Device
Configuration Wizard:

¢ Make sure that you have correctly configured your storage devices for Windows.
NetBackup cannot function reliably unless devices are correctly installed and
configured.

¢ As part of the Device Configuration Wizard, in the Device Hosts window, you must
specify the hosts on which to auto-discover and configure devices. This step applies to
NetBackup Enterprise only.

¢ From the Backup Devices window, confirm the list of devices displayed. If a known
backup device does not appear in this list, do the following:

a. Click the Cancel button and close out of this wizard.
b. Verify that the backup device is physically attached to the host.

€. Verify all installation procedures specified by the device and operating system
vendor have been performed successfully.

Note The VERITAS Tape Device Driver Install wizard (preloaded on your CD) will step
you through the process of installing the latest device drivers. If you do not have a
CD, you can download the NetBackup Tape Installer software from the VERITAS
support web site.

d. Return to the NetBackup Administration Console and click the Configure
Storage Devices link and begin this process again.

¢ After the device configuration update completes, the Configure Storage Units
window appears. Use this window to define storage units. When entering a path for a
storage unit, the following rules apply:

¢ Use the correct path separators (/ and \).
¢ Use a colon (:) to specify a drive separation on Windows platforms.

¢ Use the following characters only:
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¢ Alphabetic characters (ASCII A-X, a-z)
¢ Numeric characters (0-9)

¢ Miscellaneous characters: Plus (+), minus (-), underscore (_), or period (.)

Note When configuring devices for NetBackup in a cluster, ensure that you perform a

storage device configuration on each node. First perform a storage device
configuration on the active node. Then move the NetBackup active node to another
node and perform the storage device configuration on that node. Perform this same
procedure on each node of the cluster that NetBackup will run on.

Configuring Volumes

The Volume Configuration Wizard enables you to initiate an inventory of each configured
robot. NetBackup automatically updates the volume database if it finds new robotic
media during the inventory. In addition, you can define new volumes for use in
standalone drives. For more detailed information about volumes or configuring volumes
for standalone drives, refer the to Media Manager System Administrator’s Guide.

L 4
L 4

Select a robot to inventory or the drive type that you want to configure.

If you specify a standalone media, you will determine the number of volumes for
your device, and complete this process.

If you specify multiple drive types the following is true:

¢ Arobot is considered to have more than one type of drive if the media written in
any one drive cannot be read or written in any other drive.

¢ If the robot has more than one type of drive, then the wizard cannot inventory the
robot.

After the inventory process of your device completes, the software prompts you to
identify which slots within your device contain cleaning media.

If you have just upgraded NetBackup and have pre-existing barcode rules, then the
barcode reader will automatically detect slots designated for cleaning media.
Otherwise, if you do not designate a cleaning slot(s), then NetBackup will consider all
media (including cleaning media) as typical media and try to overwrite it.

This wizard does not enable you to configure cleaning tapes for standalone drives.
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Configure the Catalog Backup

After you have configured your storage devices and volumes, the Catalog Backup Wizard
leads you into configuration of the catalog backup. The NetBackup Catalog contains
information about your configuration and about the files and folders that have been
backed up. If a disk fails and your catalog is lost, a backup of your catalog makes it much
easier to restore your backed-up data and resume your backup schedule. Therefore, you
must configure a catalog backup before backing up any other data.

Be aware of the following tips as you complete this wizard.
¢ Specify the media server that will perform the backup.

¢ From the NetBackup Catalog Files window, you will need to verify that the master
server's and each media server's catalogs are included in the list. Verify that the
absolute path names are correct and are in the correct format.

The path names of the catalogs on the master server are automatically added during
installation and generally require no action on your part other than to ensure they are
listed. However, if you have moved the location of your catalog on your master
server, the new location must be specified. Pathnames to the NetBackup Catalog on
the media servers are not automatically added during installation and require that
you add them to the file list. For more information on specifying the pathnames, see
NetBackup System Administrator’s Guide for Windows, Volume I.

Caution Make sure there are no invalid paths in the list of catalog files to be backed up,
especially after moving catalog files, deleting old paths, or adding new paths to
the catalog backup configuration as explained in this chapter. If NetBackup
cannot find or follow a path, the entire catalog backup fails. If you have
installed NetBackup in a MSCS or VCS 1.2.1 for NT cluster environment, verify
that the NetBackup Catalog Backup entries are correct. See the NetBackup
System Administrator’s Guide for Windows, Volume I for more information.

¢ The Alternating Destinations window enables you to specify a second location for
backing up the Catalog.

Create a Backup Policy

After you have configured your catalog backup, the Backup Policy Configuration Wizard
leads you into the configuration of a backup policy. In this process you define a backup
policy for a group of one or more clients. This means specifying when the backups will
take place, the files you want to back up, the clients you want to back up, and other
general attributes that define how the backup is performed. For additional information
about creating and administering policies, refer to the NetBackup System Administrator’s
Guide for Windows.
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¢ From the Client List window you can add, change, or delete clients to this policy.

NetBackup will back up all clients in this list. In addition, If the Detect operating
system when adding or changing a client check box is selected and the operating
system of the system named cannot be determined, a drop-down box will appear to
help you select the correct operating system.

After you have successfully created a policy, you can elect to create additional policies
by checking the Create another NetBackup Policy check box and clicking Next.

Testing the NetBackup Installation

After you have finished configuring NetBackup, you have the opportunity to test your
NetBackup configuration by initiating an immediate backup based on the configuration
process you just completed.

1.

Click the Start an immediate backup of NetBackup server to verify the installation
check box.

Click Next. The Getting Started - Setup is Complete window appears. You have
completed a basic installation and configuration of NetBackup.

After you click Finish, NetBackup will begin the backup process according to your
installation configuration.

In addition, a help window appears and the Activity Monitor in the NetBackup
Administration Console updates and monitors the status of this backup. You can view
this status by selecting the Activity Monitor in the NetBackup Administration
Console.

You can then right-click on the server icon in the Topology window pane and select
Job Details. The Job Details window appears and provides a status of the current job.
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This chapter discusses how to install NetBackup client software for the following
NetBackup clients:

& Microsoft Windows clients
¢ UNIX clients (including MacOS X 10.2.x)

NetBackup’s Novell NetWare Client - For information on how to install, configure, and
use NetBackup’s Novell NetWare Client to back up and restore data that resides on a
NetWare file server, refer to the NetBackup Novell NetWare Client System Administrator’s
Guide.

Installing NetBackup on Microsoft Windows Clients

By definition, your NetBackup server is also a NetBackup client. When you installed the
NetBackup server software, both the NetBackup server and NetBackup client software
were installed on the server.

This chapter contains the following topics on installing this version of the NetBackup
client software for Microsoft Windows clients:

“Installation Overview” on page 84

“System Requirements” on page 86

“Local Installation Instructions” on page 87
“Remote Installation Instructions” on page 88
“Silent Installation Instructions” on page 90

“NetBackup Client Configuration” on page 92

® 6 6 6 6 o o

“Uninstalling NetBackup Client Software” on page 92
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Installation Overview

The NetBackup client setup program for Microsoft Windows allows you to select
appropriate setup and installation options from a series of windows. Once the options
have been selected, the NetBackup client setup program displays a window that enables
you to verify your selections before continuing with the actual install.

While the installation is in progress, a dialog provides details of the installation and setup
progress. When complete, a final window indicates the results of the installation.

Note You cannot install NetBackup client software on PCs that currently have NetBackup
server software installed. In these cases, you must first uninstall the NetBackup
server software, refer to the NetBackup Installation Guide for Windows.

VERITAS Volume Snapshot Provider

If installing on a Windows client, during the installation process you have the option of
installing VERITAS Volume Snapshot Provider (VSP). VSP establishes a point-in-time
view, or snapshot, of the data that is selected for backup on the volumes (that is, drives).
NetBackup then backs up the selected files as they existed at the time of the snapshot,
regardless of file system activity. VSP uses a file system cache to store changes that occur
during the backup. Each volume for which a snapshot is created will have a
corresponding VSP cache file.

For information on the VSP parameters, please refer to the NetBackup Backup, Archive, and
Restore Getting Started Guide. In addition, refer to the NetBackup System Administrator’s
Guide for UNIX and Windows, Volume 1.

User-Directed Operations for Windows Systems

On Windows 2000, Windows XP, or Windows 2003 Server systems, the Program Files
folder, by default, is not writable by users other than the administrator. NetBackup writes
log files and progress files to the Program Files\VERITAS\NetBackup\Logs folder,
by default. Users without write permission to the Logs folder receive an error message
when attempting a backup or restore and the operation is aborted. If users other than the
administrator will be using the Backup, Archive, and Restore interface to perform
backups and restores, make sure they have write permission to the Logs directory.

Local and Remote Installations
The NetBackup client setup program can be used in either of the following ways:

¢ Local installations: The setup program installs the client software only on the PC
where the installation is started.
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¢ Remote installations: The setup program scans your network for available clients
where you can install the client software. The source PC (or primary node) must have
Windows NT, Windows 2000, Windows XP, or Windows 2003 server installed. In
addition, a remote installation requires system administrator privileges and is only
available for Windows NT, Windows 2000, 32-bit Windows XP, and32-bit Windows
2003 machines.

Note You cannot remotely install from a UNIX system to Windows NT,
Windows 2000, Windows XP, or Windows 2003 machines.

Local and remote installations can be either new or upgrade installations, depending on
whether there is any existing NetBackup client software installed on the client PCs.

Silent Installations

A silent installation is one in which the installation process does not require interactive
input. It does, however, require that the silentclient.cmd file be edited before
executing the file.

New and Upgrade Installations
The NetBackup client setup program recognizes two types of installations:

¢ New installations: The setup program does not detect an existing version of
NetBackup client software on the client PC.

¢ Upgrade installations: Using Windows registry information, the setup program
detects an existing version of NetBackup client software.

New Installations

NetBackup setup enables you to specify one set of configuration options to be used for all
new installations. These options include:

¢ For typical and custom installations, specifying master and media server names
¢ For custom installations only:
¢ Specifying an installation directory (local install only)
Entering bpcd and bprd port numbers
Starting the NetBackup Client Service automatically or manually
Starting the NetBackup Client Service on the client after installation is complete
Starting the NetBackup Client Job Tracker automatically
Installing VSP

* 6 6 o o

Chapter 7, Installing NetBackup Client Software 8%



Installing NetBackup on Microsoft Windows Clients

¢ Installing debug symbols
¢ Installing the NetBackup documentation

Upgrade Existing Installations of NetBackup

The setup program enables you to specify the same options previously defined for new
installations, except that you cannot change the location of the installation. These options
can be applied to the upgrade installations as well as to new installations.

System Requirements

This section describes the hardware and software that is required for successful
installation of NetBackup software.

Client Installation Requirements

To install NetBackup client software on a PC, the system must meet the following
configuration requirements.

4

Microsoft Windows (NT, 2000, XP (32- and 64-bit), and 2003 Server (32- and 64-bit))
¢ Windows NT 4.0 (service pack 6A) or Windows 2000 (service pack 2) installed.
An Intel Pentium or Itanium processor

Internet Explorer 5.5 or greater

Any TCP/IP transport that is Windows Sockets Compliant. (Use of the TCP/IP
transport that comes with the server or operating system is recommended.)

A network adapter supported by your TCP/IP transport.

Remote Installation Requirements

In addition to the previous requirements:

*

*

The source PC must have Windows NT, Windows 2000, Windows XP, or
Windows 2003 Server installed.

The destination PC must have Windows NT, Windows 2000, 32-bit Windows XP, or
32-bit Windows 2003 client installed.

The person performing the remote installation must have administrator privileges on
all of the client PCs.
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NetBackup Server Requirements

The version of the NetBackup server software must be the same or newer than the version
you install on the client.

Local Installation Instructions

Follow these instructions to install the NetBackup client software on your Windows
system. You can stop the installation process at any time by clicking Cancel or clicking
Back to return to the previous window.

v To install the NetBackup client software on your Windows system
1. Log in as Administrator on the server where you will be installing NetBackup.

2. Insert the NetBackup installation CD (for Windows) into the drive.

¢ On systems with AutoPlay enabled for CD-ROM drives, the NetBackup install
program starts automatically.

¢ On systems that have AutoPlay disabled, run the Launch. exe program in the
root directory on the CD.
3. The NetBackup browser displays the following information and options:

¢ Links on the left side of the browser that display information relating to
NetBackup, Database Agents, and Additional Products.

¢ Browse the CD
¢ The NetBackup link selected (by default) and these available options:
¢ Begin NetBackup Installation
¢ View available documentation
¢ Link to VERITAS Technical Support
¢ Link to VERITAS e-Learning

4. Click Begin NetBackup Installation.
5. Click Start NetBackup Client Installation.

6. When prompted to choose where you want to install the NetBackup client software,
select Install to this computer only.

7. Select either a typical or custom installation.
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8.

9.

If you choose a typical installation, the default port numbers and default service
startup settings are used.

If you choose a custom installation, you can choose the desired service startup
settings, change the port numbers, select the installation location, and choose whether
or not to install NetBackup documentation, debug symbols, and VSP.

Click Next.

Follow the instructions provided with the program wizard.

10. Click Install to initiate the installation and Finish when the install is complete.

Note You may need to reboot your PC for the changes to take effect.

Remote Installation Instructions

Note Review the installation “System Requirements” on page 86 for remote installations

before starting this procedure.

Follow these instructions to install the NetBackup client software on selected

Windows NT, Windows 2000, 32-bit Windows XP, or 32-bit Windows 2003 Server clients

on your network (one of these clients can be your local PC). You may stop the installation

process at any time by clicking Cancel.

Notes on Remote Installations

¢ During installation, the client name is written to the registry in lower case. If the

policies on the NetBackup server do not specify the client names in lower case,
backups will fail because the names do not match.

You must have administrator privileges on the remote client for the NetBackup install
to complete successfully.

The NetBackup client setup program cannot clean an aborted install. Therefore, if you
stop Setup while it is copying files to a client, the files that have been successfully
installed are not uninstalled.

¥ To install NetBackup client software on remote computers

1.

Insert the NetBackup installation CD (for Windows) into the drive.

¢ On systems with AutoPlay enabled for CD-ROM drives, the NetBackup install
program starts automatically.
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7.

8.

¢ On systems that have AutoPlay disabled, run the Launch . exe program in the
root directory on the CD.

Click NetBackup Installation.

Click Start NetBackup Client Installation.

Note You cannot do a remote install to or from any 64-bit system.

When prompted to select where you want to install the NetBackup client software,
choose Select from available computers on the network.

Note If you choose Select from available computers on the network, the client will
not be installed on the local machine unless it is added to the list of systems to
which you are going to install.

Select either a typical or custom installation.

If you choose a typical installation, the default port numbers and default service
startup settings are used.

If you choose a custom installation, you can choose not to install debug symbols, VSP,
and can change the port numbers.

Click Next.
Follow the instructions provided with the program wizard.

Click Install to initiate the installation and Finish when the install is complete.

Note Clicking the Cancel button anytime after you have clicked the Install button and

started the remote install process will not cancel the install on the remote system
that is in progress at the time Cancel is clicked. The installation continues until it is
finished. Any remote installs that remain are not performed, and any remote installs
that were successful to that point will continue to be successful.

Note You may need to reboot your PC or the remote systems for the changes to take

effect.
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Silent Installation Instructions

Note Silent installations of NetBackup client software are not supported if you want to
run the NetBackup services as a user rather than local administrator. If you want to
install NetBackup under this circumstance, you must go through the interactive
installation described earlier in this document.

A silent installation is one in which the installation process does not require interactive
input. It does, however, require that the silentclient.cmd file be edited before
executing the file.

Follow these instructions to perform a silent installation of the NetBackup client software
on selected Windows clients on your network (one of these clients can be your local PC).

Vv To perform a silent installation

1. Start the Windows Installer from the following locations:
¢ Windows NT systems
PC_Clnt\X86\instmsiw.exe
¢ Windows 2000, Windows XP, or Windows 2003 Server
Insert the NetBackup installation CD (for Windows) into the drive.

On systems with AutoPlay enabled for CD-ROM drives, the NetBackup install
program starts automatically. Exit out of the NetBackup install program.

Note Donotrun instmsiw.exe on Windows 2000, Windows XP, or Windows 2003
Server systems.

2. Using Microsoft Windows Explorer, navigate to the CD drive.

3. Copy the contents of the PC_C1lnt\ directory to a temp folder on your hard drive
(for example, C: \ temp).

4. The files contained on the CD-ROM are read-only. Change the permissions for these
files on the hard drive to allow the update.

5. In the temporary directory, use a text editor to edit the silentclient.cmd file so
the script installs the client software as you wish.

Note Be sure to update the client, master server, and additional servers to the minimum
required version level of NetBackup.
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6. Run the script (silentclient.cmd).

7. Check the NetBackup Install.log log file to verify that the install was
successful. The following procedures will help you locate the proper log file.

Vv To locate the NetBackup installation log file for Windows 2000 and newer systems

a. Select Start > Programs > Accessories > Command Prompt. A Command Prompt
window appears.

b. Enter echo $TEMP% and press the Return key on your keyboard. The location of
your TEMP directory will display.

v To locate the NetBackup installation log file for Windows NT systems

a. Select Start > Settings > Control Panel. The Control Panel window appears.

Note Make sure you can view all hidden files and folders. To set this option, select Tools
> Folder Options... in the Control Panel window. Then click the View tab; set the
Show hidden files and folders option, and click the OK button.

b. Double-click the System icon. The System Properties window appears.

c. Click the Environment tab. The Environment Variables including the TEMP
variable will appear along with the corresponding paths for each variable.

Note By default, a silent install will not reboot your system.

VERITAS recommends that when you upgrade or patch a client or server, make
sure no backup processes are currently running. However in rare circumstances a
reboot may be required for the changes to take effect. To detect if a reboot is needed
after you have run the silentcmd.cmd., locate the %TEMP%\NetBackup Install.log ,
search for the key words “in use”. If files are in use, a reboot is required.

To force a reboot when required during a silent install, modify the script
(silentcmd.cmd) and remove this option, REBOOT="ReallySuppress" WARNING:
This will reboot the system you are installing to without warning.
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NetBackup Client Configuration

You can further configure the NetBackup client after installation by performing one of the
following actions:

¢ To add servers or media servers, start the Backup, Archive, and Restore interface and
from the File menu choose Specify NetBackup Machines.

¢ Todisplay and change the client properties, start the Backup, Archive, and Restore
interface and from the File menu, choose NetBackup Client Properties.

¢ To display and change the server properties, start the NetBackup Administration
Console. Expand Host Properties and click on Clients. In the right pane, right-click
on the client, and choose Properties.

All NetBackup servers that require access to your Windows client must be listed on the
Servers tab in the above dialog.

For more information, refer to the NetBackup User’s Guide for Windows.

Uninstalling NetBackup Client Software

¥ To uninstall the NetBackup client software on Microsoft Windows clients
1. Open the Windows Control Panel (select Start, Settings, and then Control Panel).
2. Select Add/Remove Programs.
3. Select VERITAS NetBackup Client.

4. C(Click the Remove button.
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Installing UNIX NetBackup Client Software

You can install UNIX NetBackup client software either locally at the client computer or
remotely from your UNIX NetBackup server. To have the ability to include a client in a
policy, the software for the client type must first be loaded on the UNIX server.

Note If you are running NetBackup on a Windows NT, Windows 2000, Windows 2003
server computer, or if there is a firewall that prevents remote installation, you
cannot push an install to a UNIX client. You must install UNIX clients locally.

Note The Macintosh OS X10.2.x clients are UNIX-based clients and as such, you should
follow the UNIX client installation procedures that follow.

¢ Locally: you must install the client software locally if remote installation is not
possible. Remote installation is not possible if your NetBackup server is a
Windows NT, Windows 2000, or Windows 2003 computer or if there is a firewall
that prevents remote installation.

To install NetBackup locally on IBM zSeries Linux clients, you must transfer the
contents of the NetBackup CD image to a location that is readable by the virtual
Linux environment. This can be done by using FIP or NFS mounting commands.

¢ Remotely: you can push the client software from your UNIX NetBackup server to
your UNIX client computers. This is the preferred method of installing. To push a
UNIX client, the software for that type of UNIX computer must first be loaded
onto your UNIX server and the UNIX client must be a true client and not a media
or master server. If you did not choose to do this during the installation of your
UNIX server, do so now by following the instructions provided in in the
NetBackup Installation Guide for UNIX. Clients such as the IBM zSeries Linux may
not have a locally mounted CD-ROM device, making it impossible to perform a
standard local install. To install NetBackup to clients with no local CD-ROM
drive, you must push the NetBackup installation from a UNIX master server. For
instructions on how to install NetBackup on a secure client, refer to “To install
NetBackup software on secure UNIX clients” on page 98. For instructions on how
to install NetBackup on an unsecure client, refer to “To install NetBackup
software on trusting UNIX clients” on page 95.

Note In a clustered environment, the capability to push client software is only
available from the active node.

To initiate a backup or a restore from a UNIX client computer, the following graphical
interfaces are available:
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¢ Clients that are compatible with NetBackup-Java may use the NetBackup-Java
interface (jbpSa). Refer to the NetBackup Release Notes for UNIX and Windows for a
list of NetBackup-Java capable hosts.

¢ Clients that are not compatible with NetBackup-Java may use the xbp interface
(except the Macintosh OS X 10.2.x). Refer to the NetBackup Release Notes for UNIX
and Windows for a list of clients with xbp installed. In addition, for instructions on
how to use the xbp interface, see the NetBackup Backup, Archive, and Restore
Getting Started Guide.

Note For this release, the IBM zSeries Linux clients (Linux SuSe and Linux RedHat) do
not support the NetBackup-Java Console or the xbp interface.

Note Macintosh OS X 10.2.x and FreeBSD are available through the bp interface or from a
Solaris, HP-UX, AIX, Tru64, or Linux NetBackup client console using the jbpSa
command.

Installing Client Software Locally
V¥ To install client software locally
1. Insert the NetBackup CD-ROM into the drive on the client computer.
a. HP-UX systems only: Because the NetBackup CD-ROM is Rockridge-formatted,
the mounting instructions are slightly different. Refer to in the NetBackup

Installation Guide for UNIX for specific instructions.

b. Macintosh OS X 10.2.x systems only: you can access the CD-ROM from:

/volumes/cd name

2. Change your working directory to the CD-ROM directory:
cd cd_rom _directory
Where cd_rom_directory is the path to the directory where you can access the
CD-ROM. On some platforms, it may be necessary to mount the directory.
3. Start the install program.

./install

4. Choose option 2, NetBackup Client Software.
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Note The binaries provided for the client OS levels represent the OS levels on which the
binaries were compiled. Often the binaries will function perfectly on newer versions
of the operating system. For example, Solaris 7 binaries also are used on the
Solaris 8 level of the operating system.

The install script attempts to load the appropriate binaries for your system. If the
script does not recognize the local OS, it will present choices to the user.

5. Follow the prompts to complete the installation.

6. On HP-UX systems only: to unmount the CD-ROM:
¢ Run the pfs_umount command
¢ Use the kill command to kill the following processes:

pfs_mountd
pfsd
pfs_mountd.rpc
pfsd.rpc

Installing Client Software Remotely

The following sections describe how to push the client software from your UNIX
NetBackup server to your UNIX NetBackup clients. You can push the client software to
either a trusting client or a secure client.

¥ To install NetBackup software on trusting UNIX clients

Note In a clustered environment, the capability to push client software is only available
from the active node.

A trusting UNIX client is one that has an entry for the server inits / . rhosts file. The
/ .rhosts entries enable software installation, but are not necessary for correct operation
of NetBackup software.

Note Add the trusting clients to a backup policy, if this has not already been done.

Note For Macintosh OS X 10.2.x users: By default, Macintosh OS X 10.2.x does not enable
the remote shell daemon (rshd). You must enable this daemon to perform the
following procedure successfully. You can enable rshd by removing the
commenting in the “shell” line in the /etc/inetd. conf file and sending an HUP
signal to the inetd process.
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1. Start the NetBackup Administration Console.

In the Login dialog, type the name of the NetBackup server that contains the policy
configuration with the clients.

You can install the client software only from the NetBackup server that you specify in
the Login dialog when starting the interface. The clients must be defined in a policy
on this NetBackup server.

2. In the NetBackup Administration Console window, click on the NetBackup
Management icon to show the available options.

3. Click Policies in the left pane. The All Policies pane populates with a list of available
policies.

4. Select the master server in the All Policies pane.

ies - hagar - NetBackup Admini Console [logged into hagar]

VERITAS NetBackup™

File Edit View Actions Help

BlesnfldREY xBX <8 @

hagar (Master Server) : All Policies : hagar: 8 Policies
B hagar (Master Serven 1= hagar (Master Server) £ Mame | Type | Storage Unit | Volume Pool
B} Backup, Archive, and Restore | & & Surmnmary of All Policies A\ TEMP_FOLICY Standard <any= MNetBackup
g Activity Monitor | = @ TEMP_POLICY 2| @ template_normal Standard <ary> NetBackup
? = ";“k“r? Managerment ; z@ termplate_normal |@ ternpiate_weekend  Standard <ary> NetBackup
enors a template_weekend @ test_pal_1 ME-Windows-NT  =any= MetBackup
3 Palisies | & @ test pol 1 @ test_pol_2 MEWindows-NT  <any= NelBack
© () Storage Units 1o @ et po 2 : est_pal_ indows-| any: etBackup
& catalog | o @ unix_clients (@ unix_clients Standard =any MetBackup
© §d Host Properties | & @ vsr_db_backups A[@ vsm_oh_backups  Standard =any MetBackup
@ B9 tedia and Device hanagement | ) & @ windows_clients | @ windows_clients WS indows-NT  <any= MetBackup

Lo @ Access Management
E Filesystem Analyzer
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5. Select Install UNIX Client Software from the Actions menu.
The Install UNIX Client Software dialog appears.

[ Install UNIX Client Software

@ Only UNIX clients can be installed.

Don't install these clients: Install these clients:
| Client Name | Qperating Systern \ Client Name Qperating Systern
i) 3
= 2
= hagar Solarisg
=
=
Install Client Software

Progress:

[ET] 0]

6. In the Don't install these clients list, select the clients you want to install and click
Add >>.

The clients are moved to the Install these clients list.

7. Click Install Client Software to start the installation.

Client software installation can take a minute or more per client. NetBackup writes
messages in the Progress box as the installation proceeds. If the installation fails on a
client, NetBackup notifies you but keeps the client in the policy. You cannot stop the
installation once it has started.

During installation, NetBackup does the following;:

¢ Copies the client software from the /usr/openv/netbackup/client directory
on the server to the /usr/openv/netbackup directory on the client, as long as
the client is not a media or master server.

¢ Adds the required entries to the client’s /etc/services and inetd. conf files
or xinetd.d directory as appropriate.
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The only way to install client software to a different location on the client is to create
the directory where you want the software to reside and then create /usr/openv asa
link to that directory prior to installing software.

8. When the install is complete, click Close.

¥ To install NetBackup software on secure UNIX clients

As defined here, a secure UNIX client is one that does not have an entry for the NetBackup
server in its / . rhosts file.

Note Add the secure clients to a backup policy, if this has not already been done.

Note For Macintosh OS X 10.2.x users: By default, Macintosh OS X 10.2.x does not enable
the FTP daemon (ftpd). You must enable this daemon to perform the following
procedure successfully. You can enable ftpd by checking Allow FTP access in the
sharing pane of the System Preferences application.

1. Move software from the server to temporary space in the / tmp directory on the client
by running the install_client_files script from the NetBackup server. To run
this script, you must have a login ID and password that you can use to access the
clients through ftp.

To move software to only one client at a time, run:
/usr/openv/netbackup/bin/install_client_files ftp client user
To move software to all clients at once, run:
/usr/openv/netbackup/bin/install_client_files ftp ALL user
Where the options are defined as follows:

& client is the hostname of the client.

¢ user is the login id required by ftp on the client.

¢ ALL specifies that you want to install all clients which are configured in any
backup policy on the server.

The install_client_files script prompts you for a password for each client if
you do not have a .netrc file set up.

Note In a clustered environment, the capability to push client software is only available
from the active node.

2. Afterthe install_client_files scriptis done, the root user on each of the clients
must run the client_config script to complete the installation:
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sh /tmp/bp/bin/client_config

The client_config script installs the binaries and updates the /etc/services
and inetd. conf files on the client or xinetd.d directory as appropriate.

Adding a UNIX Client Type After Initial Server Installation

If you add a new UNIX client type to your backup environment or forgot to select a UNIX
client platform during your NetBackup installation, you must first load the NetBackup
client software onto the NetBackup server as described below.

v To add a UNIX client type after initial server installation

Note In a clustered environment, the following steps should be performed on the active

node.

4,

5.

Insert the NetBackup CD-ROM into the drive on the server.
On HP-UX systems only: Because the NetBackup CD-ROM is Rockridge-formatted, the
mounting instructions are slightly different. Refer to in the NetBackup Installation
Guide for UNIXfor specific instructions.
Change your working directory to the CD-ROM directory:

cd cd_rom _directory
Where cd_rom_directory is the path to the directory where you can access the
CD-ROM. On some platforms, it may be necessary to mount the directory.
Use the install program to load the client software onto the NetBackup server.

./install
Choose option 2, NetBackup Client Software.

Follow the prompts, selecting the additional client platforms that you want.

Note The binaries provided for the client OS levels represent the OS levels on which the

binaries were compiled. Often the binaries will function perfectly on newer versions
of the operating system. For example, Solaris 7 binaries also are used on the
Solaris 8 level of the operating system.

6.

7.

Follow the prompts to complete the installation.

On HP-UX systems only: to unmount the CD-ROM:
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¢ Run the pfs_umount command
¢ Use the kill command to kill the following processes:

pfs_mountd
pfsd
pfs_mountd.rpc
pfsd.rpc

8. You must now install the NetBackup client software on these additional client
computers, as described earlier in this chapter. Refer to “Installing Client Software
Remotely” on page 95.
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Uninstalling UNIX NetBackup Client Software

If you are uninstalling NetBackup from a machine on which you have installed the
NetBackup-Java Display Console, the Console will be also be removed when uninstalling
NetBackup. You will need to reinstall the Console in order to continue using it on the
machine.

¥ To uninstall UNIX NetBackup client software
1. Log on to the client system as the root user.

2. Remove the /usr/openv directory.
-If /usr/openv is a physical directory, execute:
rm -rf /usr/openv

-If /usr/openv is a link, execute:

a. cd /usr/openv

Note Make sure you are at the proper location and verify that the subdirectories are
what you would expect them to be before continuing to Step b. You do not want
to remove the wrong directories. To verify your current location and the
contents of that location, perform the following two steps before proceeding to
Step b.

pwd
1s

b. rm -rf *
c. cd /

d. rm -f /usr/openv

Caution Therm -f /usr/openv command will also uninstall any add-on products
installed on this machine.

3. Remove NetBackup entries in the /etc/services file, as follows:
a. Edit the client’s /etc/services file.

b. Locate the lines marked by the following and remove them:

# NetBackup services#
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# End NetBackup services #

# Media Manager services #

# End Media Manager services #

Note For Macintosh OS X 10.2.x systems, the NetBackup installer updates the
/services directory of the Netinfo database with these entries. To uninstall
NetBackup and its services from one of these clients, you must use the NetManager
utility to remove bpcd, bpjava-msve, bprd, vnetd, and vopied from the
/services directory in the Netinfo database.

4. Remove the NetBackup entries in the /etc/inetd. conf file.
a. Edit the client’s /etc/inetd. conf file.
b. Delete the lines for bpcd, vnetd, vopied, and bpjava-msvc.

5. Run the following two shell commands to cause inetd to read the updated
inetd.conf (or inetd.local) file.
a. Enter the following.
For most UNIX clients:
ps -ea | grep inetd
For MacOS X 10.2.x and FreeBSD:
ps -ax | grep inetd
b. Run the kill command as follows. The process ID is the first number displayed
in the output from the ps command.
kill -1 process_1ID
The ps command options may vary from one client platform to another.
6. For NetBackup-Java capable clients running the NetBackup Administration Console
for UNIX, remove the NetBackup-Java state data by executing the following:
/bin/rm -rf /.nbjava

/bin/rm -rf /.java/.userPrefs/vrts
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Caution There should be no space between the slash “/” and the period “.” of
“/.nbjava”. Adding a space between these characters removes all of your files
starting from the root level.

7. Inform users of this machine that they can remove their $HOME/ .nbjava and
portions of SHOME/ . java directories.

The $HOME/ .nbjava and $HOME/ . java directories contain application state
information (for example, table column order and size) that is saved when the user
exits NetBackup-Java applications.

The common subdirectory in $HOME/ . java/.userPrefs/vrts can be removed.

8. If NetBackup Access Control is enabled, NetBackup creates several new files on
clients and servers. For more information on NetBackup Access Control, please see
the NetBackup System Administrator’s Guide, Volume II. For more information on the
VERITAS Security Services, including how to properly uninstall, please see the
VERITAS Security Subsystem Administrator’s Guide.

These files can be divided into two separate categories: individual user files, and
NetBackup application temporary files. NetBackup application temporary files were
removed with NetBackup in a previous step. Users’ cache files exist in their home
directories, for example: $HOME/ . vxss

Inform those users that they can remove their $HOME/ . vxss directory.

Installing Mac OS X 10.2.x Clients

The Macintosh OS X 10.2.x clients are UNIX-based clients that have the same installation
requirements. To install these clients, you should follow the UNIX client installation
procedures. Refer to “Installing UNIX NetBackup Client Software” on page 93.
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This chapter contains basic information on entering license keys and also provides some
questions and answers regarding license keys. For detailed information and procedures

on how to administer license keys refer to the NetBackup System Administration Guide for

Windows, Volume I.

NetBackup 5.1 Licenses

In previous versions of NetBackup there were separate licenses for both NetBackup
DataCenter and NetBackup BusinesServer, for the server licenses, and the database agents
and options. NetBackup 5.1 enables all existing permanent license keys being used by
customers today, to remain valid for use with this release of NetBackup. However, it is
important to understand how the previous NetBackup products, specifically NetBackup
BusinesServer and NetBackup DataCenter, map to both of the server licenses as well as
the database agents and options of NetBackup 5.1.

NetBackup 5.1 offers a NetBackup Enterprise Server and a NetBackup Server product.
The NetBackup Enterprise Server is the next generation of the DataCenter product and
the NetBackup Server is the evolution of the BusinesServer product. Therefore, the
DataCenter and BusinesServer keys will, for the server licenses, turn on their respective
next generation product. DataCenter server licenses, when used with NetBackup 5.1
media provides a NetBackup Enterprise Server product. The BusinesServer server licenses
will update the customer into the Server product, when used with NetBackup 5.1 media.

As for the database agents and options license keys, the compatibly between

NetBackup 3.4, 4.5, 5.0, and now 5.1 is a little different. The NetBackup 5.0 and 5.1
product line changes include a single database agent and options offering for both the
NetBackup Enterprise Server and NetBackup Server offerings. In other words, there will
not be separate license keys or separate pricing for each database agent or option in
NetBackup 5.0 and 5.1. For example, there is just one Oracle Agent available for purchase
to use with either the NetBackup Enterprise Server or NetBackup Server product.

Therefore, the NetBackup 3.4 and NetBackup 4.5 license keys for each database agent or
option will turn on the same database agent or option when used with NetBackup 5.0 and
5.1 media. Using the Oracle Agent as an example, the NetBackup 4.5 DataCenter Oracle
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Agent license key will turn on the NetBackup 5.0 Oracle Agent in a NetBackup 5.0 and 5.1
Enterprise Server environment. And a NetBackup 4.5 BusinesServer Oracle agent will
turn on the NetBackup 5.0 Oracle agent in the NetBackup 5.0 and 5.1 Server environment.

Entering License Keys

During the installation of NetBackup on a master server, you are prompted to enter your
product license key. During the installation procedure, you are directed to enter all of the
license keys that you have. VERITAS recommends that you enter all of your license keys
when you are prompted by the install script. However, if you did not enter all of your
license keys, you can open the NetBackup Administration Console and select Help >
License Keys... and then enter your keys at a later time, or use get_license_key on
UNIX systems.

One of the most frequently asked questions that a users asks is, “which server should I
enter my license keys if I did not enter all of my keys during the installation?” All product
license keys must be entered on the master server. However, some features and products
require the keys to also be installed on the media server. The following list identifies
features of NetBackup that require keys to be installed on the media servers in addition to
the master servers.

¢ NetBackup SAN Shared Storage Option (SSO)
¢ Library-based Tape Drives
¢ NetBackup Offthost Data Mover

Finally, customers can view, enter, and administer licenses from almost any server within
a system. Because of this, if you are attempting to administer license keys remotely, you
must be sure you are viewing the licenses of the system you intend to change to avoid
adding or changing a license on the wrong server.

The following section contains some common questions that may help you understand
how to manage your license keys.
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Frequently Asked Questions

The following list contains questions that VERITAS customers have asked about
managing license keys. If you are viewing this list using an online media format, you can
click on a question and jump directly to that question and answer.

“Is NetBackup’s licensing the same as the licensing in other VERITAS products?”
“Can I use NetBackup if all I have is a media/doc kit?”

“What does the license key look like? What information does it contain?”
“Is the license key serialized?”

“Can I see reports on what keys I have?”

“How do I enable options and agents?”

“Should I save keys after they have been entered?”

“What should I do if I have lost my license key(s)?”

“How will large volume orders be handled?”

“What about license keys for customers with site licenses?”

“Will I need a license key to enable remote administrative consoles?”
“Can a key be used multiple times?”

“How will existing customers get keys?”

“What if I do not get the right keys?”

“What does an evaluation key enable?”

“Will I be notified when an evaluation is about to expire?”

“What happens when an evaluation key expires?”

“Will backup configuration and catalog information be saved?”
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“How do I upgrade from an evaluation license to a permanent license?”

Is NetBackup’s licensing the same as the licensing in other VERITAS products?

NetBackup is implementing the common licensing system that will eventually be used by
all VERITAS products. This licensing system was developed in-house; it is not from a
third party. However, please note that different VERITAS products have different
requirements and our common licensing system provides considerable flexibility in what
licensing features will be implemented in each product. For example, NetBackup will not
have a node-locked licensing system, but other VERITAS products will.
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Can | use NetBackup if all | have is a media/doc kit?

No. The media/doc kit by itself does not allow any access to NetBackup. You will always
need a license key (either permanent or evaluation) to get up and running. License keys
should always be delivered with the media/doc kit, so you should never find yourself
with a media/doc kit and no key.

What does the license key look like? What information does it contain?

The key is a multi-digit alphanumeric string (for example:,
8EPP-ABCD-9XYZ-XYZ9-8881-VCF4-OIUF-AJDC). It contains information on whether
the key is for NetBackup Server or NetBackup Enterprise Server, whether it is for a server,
client, agent, or option (and which one), whether it is a permanent or evaluation key, and
information about how and where the key was generated.

Is the license key serialized?

Yes, there is serialization information embedded in the key.

Can | see reports on what keys | have?

Yes, information about the keys is stored at the master server and can be accessed using a
command line program (UNIX) or the NetBackup Administration Consoles (Windows
and UNIX).

How do | enable options and agents?

You will be prompted to enter all keys for options and agents at the time you install
NetBackup. If you purchase an agent or option at a later date, you can enter new license
keys using the command line and NetBackup Administration Consoles referenced above.

Many options and agents will require you to have your original NetBackup distribution
CDs because additional binaries will need to be installed. You should always keep your
NetBackup CDs in a safe or accessible place.

Should | save keys after they have been entered?

Yes, copies of the keys should always be stored in a secure place.

What should I do if | have lost my license key(s)?

VERITAS retains a record of all keys issued to VERITAS customers. Customers who lose
their license key(s) can call Order Management to get copies of their keys.

For Americas, Japan, PacRim, Australia:
Tel: 650.318.4265 FAX: 650.335.8428

For Europe, Middle East and Africa:

Tel: 00.353.61.365232 FAX: 00.353.61.365223

If you have purchased NetBackup from a VERITAS partner, contact that partner for
information on your key.
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How will large volume orders be handled?

We recognize that many NetBackup installations are very large, and entering long license
keys multiple times can be tedious and time-consuming. Therefore we have provided the
option for customers who are placing volume orders to request a single key for each type
of NetBackup component purchased. For example, a customer who is ordering 50 Lotus
Notes agents can get a single key, with a certificate stating that the key may be used for 50
Lotus Notes licenses. Even site licenses, with unrestricted use for specific NetBackup
agents or options, can be handled in this manner.

Note You will still need a unique key for each type of NetBackup component
purchased—NetBackup server, Lotus Notes agent, NDMP option, UNIX client, and
so forth.

What about license keys for customers with site licenses?

Site licenses are handled the same way that large volume orders are, however, instead of
the certificate stating that the license key is good for X number of copies of, for example,
the Lotus Notes agent, the certificate states that the license key is good for unlimited
copies of the Lotus Notes agent.

Will I need a license key to enable remote administrative consoles?

NetBackup enables customers to install remote administrative consoles. There is no
special license key required.

Can a key be used multiple times?

Yes, the keys may be used multiple times. However, you are still legally bound to only
install and use the number of NetBackup servers, clients, agents, and options for which
you have purchased licenses.

How will existing customers get keys?

All NetBackup customers who have current maintenance contracts with VERITAS
automatically receive the latest version NetBackup. You receive the NetBackup Enterprise
Server or NetBackup Server media/doc kit, and license keys for every NetBackup
component that our records indicate you have purchased licenses for.

If your maintenance is through a VERITAS partner, upgrade through the partner. Contact
the partner for more details.

What if | do not get the right keys?

If you believe you are entitled to a key that you did not receive, you should contact the
Order Management number provided on your license key certificate.
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Note VERITAS Technical Support will not issue permanent keys. This can only be done
through VERITAS Order Management. However, Technical Support is prepared to
provide temporary one-month keys to you to keep you up and running while any
issue regarding permanent license keys is resolved.

What does an evaluation key enable?

The evaluation key enables unrestricted use of NetBackup Server or NetBackup
Enterprise Server, as well as any of their options and agents, for a predetermined period of
time.

Will I be notified when an evaluation is about to expire?

You can find information concerning the expiration date of a key in the NetBackup
Administration Console by clicking Help > About NetBackup Administration Console,
by using the get_1license_key command, or looking in your system logs.

What happens when an evaluation key expires?

The daemons are shut down, and when you attempt to use the product you are informed
that the evaluation period has expired.

Will backup configuration and catalog information be saved?

Yes. Customers who add a permanent license key to an evaluation version of NetBackup
have immediate access to their catalog and configuration information.

How do | upgrade from an evaluation license to a permanent license?

It is easy. When you purchase a permanent license, add the license to NetBackup and you
are ready to go. All the configuration information and catalog data from your evaluation
version is retained.
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This appendix lists and describes the technical manuals that relate to NetBackup.

The CD-ROM for each NetBackup product has a copy of the related manuals in Adobe
Portable Document Format (PDF). The PDF files are either in the root directory or the Doc
directory on the CD-ROM.

To view the PDF copies of the manuals, you need an Adobe Acrobat reader, which you
can download from the Adobe web site at http: / /www.adobe.com. VERITAS assumes
no responsibility for the correct installation or use of the reader.

Release Notes

¢ VERITAS NetBackup Release Notes for UNIX and Windows
NetBackup_Release_Notes.pdf

Provides important information about NetBackup on UNIX- and Windows-based
servers, such as the platforms and operating systems that are supported and
operating notes that may not be in the NetBackup manuals or the online help.

¢ VERITAS NetBackup Storage Migrator Release Notes for UNIX
StoMigrator_ReleaseNotes_ UNIX.pdf

Provides information such as the platforms and operating systems that are supported
and operating notes that may not be in the Storage Migrator manuals.

Installation Guides

¢ VERITAS NetBackup Installation Guide for Windows
NetBackup_Install_Win.pdf
Explains how to install NetBackup software on Windows-based platforms.
¢ VERITAS Security Services Installation Guide
VxSS_InstallGuide.pdf on the VERITAS Security Services CD-ROM.
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Explains how to install and configure the VERITAS Security Services.

System Administrator’s Guides - Basic Product

¢ VERITAS NetBackup System Administrator’s Guide for Windows, Volume 1
NetBackup_AdminGuidel_WinServer.pdf

Explains how to configure and manage NetBackup on a Windows server, including
managing storage units, backup policies, catalogs, and host properties.

¢ VERITAS NetBackup System Administrator’s Guide for Windows, Volume 11
NetBackup_AdminGuidell_WinServer.pdf

Explains additional NetBackup features such as access control and enhanced
authorization and authentication. The guide also discusses using NetBackup with
AFS and Intelligent Disaster Recovery (IDR).

¢ VERITAS NetBackup Media Manager System Administrator’s Guide for Windows
MediaMgr_AdminGuide_Win.pdf

Explains how to configure and manage the storage devices and media on Windows
servers running NetBackup. Media Manager is part of NetBackup.

& VERITAS Security Services Administrator’s Guide
VxSS_AdminGuide.pdf on the VERITAS Security Services CD-ROM.

Explains how to configure and manage core security mechanisms, including
authentication, protected communications, and authorization.

System Administrator’s Guides - Agents and Options

¢ VERITAS NetBackup Advanced Client System Administrator’s Guide
NetBackup_AdminGuide_AdvancedClient.pdf

Explains how to install, configure, and use NetBackup Advanced Client. Advanced
Client combines the features of snapshot backup, FlashBackup, BLI Agent, offhost
backup, and Instant Recovery.

& VERITAS NetBackup Advanced Client Quick Start Guide
NetBackup_QuickStart_AdvancedClient.pdf
Provides first-time instructions for installing and configuring Advanced Client.

& VERITAS NetBackup for DB2 System Administrator’s Guide for Windows
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NetBackup_AdminGuide_DB2_Win.pdf
Explains how to install, configure, and use NetBackup for DB2.
¢ VERITAS NetBackup Encryption System Administrator’s Guide

Explains how to install, configure, and use NetBackup encryption software to provide
file-level encryption of backups and archives.

¢ VERITAS NetBackup for Informix System Administrator’s Guide
NetBackup_AdminGuide_Informix.pdf

Explains how to install, configure, and use NetBackup for Informix to back up and
restore Informix databases that are on a UNIX NetBackup client.

¢ VERITAS NetBackup for Lotus Notes System Administrator’s Guide for Windows
NetBackup_AdminGuide_LotusNotes_Win.pdf

Explains how to install, configure, and use NetBackup for Lotus Notes to back up and
restore Lotus Notes databases and transaction logs on a Windows client.

¢ VERITAS NetBackup for Microsoft Exchange Server System Administrator’s Guide
NetBackup_AdminGuide_MSExchg Win.pdf

Explains how to configure and use NetBackup for Microsoft Exchange Server to
perform online backups and restores of Microsoft Exchange Server.

¢ VERITAS NetBackup for Microsoft SQL Server System Administrator’s Guide for Windows
NetBackup_AdminGuide_MSSQL_Win.pdf

Explains how to install, configure, and use NetBackup for Microsoft SQL Server to
back up and restore Microsoft SQL Server databases and transaction logs.

¢ VERITAS NetBackup for NDMP System Administrator’s Guide
NetBackup_AdminGuide_NDMP.pdf

Explains how to install, configure, and use NetBackup for NDMP to control backups
on an NDMP host.

¢ VERITAS NetBackup for Oracle System Administrator’s Guide for Windows
NetBackup_AdminGuide_Oracle_Win.pdf

Explains how to install, configure, and use NetBackup for Microsoft Oracle to back up
and restore Oracle databases that are on a Windows NetBackup Client.

& VERITAS NetBackup for SAP System Administrator’s Guide for Windows
NetBackup_AdminGuide_SAP_Win.pdf

Explains how to install, configure, and use NetBackup for SAP on Windows-based
servers.
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VERITAS NetBackup for SYBASE System Administrator’s Guide on Windows
NetBackup_AdminGuide_Sybase_Win.pdf

Explains how to install, configure, and use NetBackup for SYBASE to back up and
restore Sybase databases that are on a Windows NetBackup client.

VERITAS NetBackup Global Data Manager System Administrator’s Guide for UNIX and
Windows

NetBackup_AdminGuide_GDM.pdf

Explains how to install, configure, and use Global Data Manager (GDM) for
NetBackup on UNIX and Windows-based operating systems.

VERITAS NetBackup High Availability System Administrator’s Guide
NetBackup_AdminGuide_HighAvailability.pdf

This guide provides information on how to install and configure NetBackup to work
with different clustering solutions.

VERITAS NetBackup Vault System Administrator’s Guide for UNIX and Windows
NetBackup_AdminGuide_Vault.pdf

Describes how to configure and use logical vaults and profiles to duplicate backups,
perform catalog backups, eject media, and generate reports.

VERITAS NetBackup Advanced Reporter System Administrator’s Guide for UNIX and
Windows

NetBackup_AdminGuide_AdvancedReporter.pdf

Explains how to install, configure, and use NetBackup Advanced Reporter to monitor
and report on NetBackup activities.

VERITAS NetBackup Storage Migrator System Administrator’s Guide for UNIX
StoMigrator_AdminGuide_UNIX.pdf
Explains how to configure and manage Storage Migrator on a UNIX system.

VERITAS NetBackup NetWare Media Server Option System Administrator’s Guide for
UNIX and Windows

NetBackup_AdminGuide_NetWareServer.pdf

This comprehensive manual provides detailed information and procedures for
installing, configuring, and using the VERITAS NetBackup NetWare Media Server
Option.
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User’s Guides

¢ VERITAS NetBackup Backup, Archive, and Restore Getting Started Guide
NetBackup_BAR_GS_Guide.pdf

Explains how to use the NetBackup Backup, Archive, and Restore interface to
perform basic backup and restore operations for UNIX and Windows systems.

¢ VERITAS NetBackup Vault Operator’s Guide for UNIX and Windows
NetBackup_OperGuide_Vault.pdf

Describes procedures for sending tapes offsite, receiving tapes on site, and running
reports on offsite media and vault jobs.

¢ VERITAS NetBackup Administrator's Guide for Novell NetWare Client
NetBackup_AdminGuide_NetWare_Client.pdf

Explains how to install and use the NetBackup’s NetWare Client software. With the
NetWare Client, full and incremental backups can be scheduled to occur
automatically and unattended under the control of the NetBackup master server. The
NetWare Client also provides two methods for performing user-directed backups and
restores: Target, which uses a character-based, menu-driven interface running on the
NetWare server, and NonTarget, which uses the NetBackup for NetWare NonTarget
Browser that is installed and run from a Windows computer.

Troubleshooting Guide
¢ VERITAS NetBackup Troubleshooting Guide for UNIX and Windows

NetBackup_Troubleshoot_Guide.pdf

Provides troubleshooting information for UNIX- and Windows-based NetBackup
products, including Media Manager.

NetBackup Commands

¢ VERITAS NetBackup Commands for Windows
NetBackup_Commands_Win.pdf

Describes NetBackup and Media Managercommands and processes that can be run
from a Windows command prompt.
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